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What's New in this Document? 1

This section describes the important changes to this document due to the new and changed
functionality in InAttend Release 8.5 SP4.

Table 1: Version 1.0

Feature/Enhancement Update Location Publish Date

CMG Server Applications Added a step to display prof
ile picture Basic Configuration

in Configuration
Manager on page
11

February 2022

Configuring Universal Se
arch in BlueStar WebServ
ice Config.xml

Added steps to To enable
 universal search in CMG
 Web Service

Configuring
Universal Search in
BlueStarWebService
Config.xml on page
43

Sep 2022

Deletion of Users Added steps For versions
 of CMG 8.5 SP4 and onwa
rd

Deletion of Users on
page 32

Sep 2022
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Introduction 2

Mitel CMG Suite is a collaboration and presence management suite enabling business users
to manage their day-to-day communications.

The CMG package includes the CMG Web component, enabling users to manage their
activities. With the CMG Web site, users can work with “smart-search” directory services, use
click-to-dial, set activity timeline and manage call-routing preferences based on the calendar/
activities.

The integration with the BluStar Server enables users to see, in real-time, their colleagues’
rich presence information, including BluStar user presence status, calendar activity and line
state from all available sources provided by the BluStar Server.

This document describes the configuration of CMG. For installation information, refer to the
following documents:

• CMG Quick Installation Guide [2] - describes how to install CMG on a single server using
the Mitel Installer wizard.

• CMG Installation Guide [3] - describes how to install CMG from the classic package
browser, to install the components one by one.

For configuration of Calendar Connection, refer to Calendar Connection Configuration Guide
[4].
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Configure CMG 3
This chapter contains the following sections:

• Configuration Tools
• Configuring CMG Server Functions
• Backing up the CMG Database
• Optimizing Nicesrv
• Configuring Advanced Security
• Configuring EFS
• Setting up Connection to the Telephony System (PBX)
• Setting up Connection to the E-mail System
• Configuring MX-ONE Provisioning Manager Integration
• Configuring Active Directory Synchronization
• Customize CMG Web
• CUSTOMIZE CUSTOMER GROUP SEARCH
• Setting up CMG Web for Visual Voicemail in the MiCollab Client
• Configuring Universal Search in BlueStarWebService Config.xml

When CMG has been installed, there is some configuration required for different parts of the
system. This is described in the following sections, starting with an overview of the different
configuration tools.

3.1 Configuration Tools

• Configuration Manager on page 3
• Directory Manager on page 5
• IIS Manager on page 10
• Spman Tool on page 10

3.1.1 Configuration Manager

Configuration Manager is a web-based tool used by system administrators to configure
and manage the CMG system.

You can access Configuration Manager either through Internet Explorer by entering the
server address in the format: http://<servername>/CMGCM, or from your server
where the product is installed (http://localhost/CMGCM).
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Configure CMG

You can also access Configuration Manager either through Edge Chromium by entering
the server address in the format: http://<servername>/CMG.CM, or from your server
where the product is installed (http://localhost/CMG.CM).

The starting point for working with Configuration Manager is the sidebar. The
sidebar consists of headings with subheadings under which you can perform various
configurations. To go to different pages, click the relevant heading.

For more information about how to use Configuration Manager, see the online help. You
can access the online help by clicking Help in the sidebar.

Note:

Google Chrome and Mozilla Firefox browsers are not supported to access CMG
Configuration Manager.

• Enable active scripting for Internet Explorer on page 4
• Configuration Manager – Security Restrictions on page 4

3.1.1.1 Enable active scripting for Internet Explorer

Active scripting is enabled to use Internet Explorer with Configuration Manager or
Directory Manager. To enable active scripting, do the following:

1. Open Internet Explorer.
2. Select Tools - Internet options from the main menu.
3. Click the Security tab, next click Custom level…
4. In the Security Settings – Internet Zone dialog, go to the Scripting section. Select

Enable for Active scripting:

3.1.1.2 Configuration Manager – Security Restrictions

As part of Polisen security issues, few characters (For example, < > ‘ $ ^ -- ) are
restricted, which are the malicious characters to hack the system.
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Configure CMG

Hence, it is not allowed to use these characters from CMG CM 8.4 onwards.

3.1.2 Directory Manager

Directory Manager is a web-based tool including a suite of functionality for management
of user information in the organization.

You can access Directory Manager either through Internet Explorer by entering the
server address in the format: http://<servername>/CMGDM, or from your server
where the product is installed (http://localhost/CMGDM).

You can also access Directory Manager either through Edge Chromium by entering the
server address in the format: http://<servername>/CMG.DM, or from your server
where the product is installed (http://localhost/CMG.DM).

The starting point for working with Directory Manager is the sidebar. The sidebar consists
of headings with subheadings under which you can perform various configurations. To go
to different pages, click the relevant heading.

For more information about how to use Directory Manager, see the online help. You can
access the online help by clicking Help in the sidebar.

Note:

Google Chrome and Mozilla Firefox browsers are not supported to access CMG
Directory Manager.

• Enable active scripting for Internet Explorer on page 5
• User Image Deletion on page 6
• Configure Logging to capture deleted users from DM application on page 8

3.1.2.1 Enable active scripting for Internet Explorer

Active scripting is enabled to use Internet Explorer with Directory Manager. This
procedure is described in above section 2.1.1.1.
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3.1.2.2 User Image Deletion

You must configure Folder permissions to delete the User image when the User is
deleted from the Directory Manager. Perform the following steps to configure the folder
permissions.

1. Browse to the physical folder that is defined in the CMG CM > CMG Web >
Parameters > LogicImageDir.

2. Right-click, Properties > Security tab and click Edit.

3. Click Add.
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4. Search IUSR and then click Ok.

5. Select Full Control permissions for the IUSR user and then click Ok.
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Note:

The deletion works only when TELNO is mapped to PictureField in CMG CM >
CMG Web > Parameters > PictureField.

3.1.2.3 Configure Logging to capture deleted users from
DM application

You must configure folder permissions and set the trace log level in order to generate the
logs that has the details of users that are deleted from DM application:

To Set Trace log level

Enable Trace log level by performing the following steps:

1. Log in to CMGCM.
2. Go to CMG Directory manager > Advanced Parameters.

3. Under Log parameters, set TraceLogLevel to 4 and click on Save to save the
changes.

To Configure Folder Permissions
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1. Browse the C:\NiceSrv\log folder, and then right click log properties dialog box
opens. In that select Properties > Security tab. Click Edit button.

2. Click Add. The Select Users or Groups window opens.

Enter IIS_IUSRS and click Check Names. Click OK.

3. In Permissions for IIS_IUSRS, select Full control and then click Apply > OK.
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4. Finally reset IIS by following the below steps:

a. Open Command prompt with run as administrator.

b. Type iisreset and click Enter.

3.1.3 IIS Manager

IIS Manager is used to configure web applications and is opened from the Windows
Control Panel.

3.1.4 Spman Tool

Spman is a tool used to handle CMG processes.

To start Spman, open the Windows Start menu/screen and search for Spman.

3.2 Configuring CMG Server Functions

This chapter includes all configuration needed for the CMG Server applications.

Note:

The Windows Start Menu is not visible in Windows Server 2012/2012 R2. In
Windows Server 2012/2012 R2, the different tools and applications to be used for
configuration of CMG are accessed from the Windows Start Screen.

• Basic Configuration in Configuration Manager on page 11
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• Add an Application Pool on page 14
• Configure BluStar Server Integration on page 14
• Configure AnA to Connect to External CMG Server on page 15
• Configure BluStar Presence Status on page 15
• Enable Click-to-Dial on page 16
• Configure which SMS Signature to use in Configuration Manager on page 17
• Enable Time Zone Functionality on page 18
• IIS configuration to access CMG CM, CMG DM and CMG WEB applications over

HTTPS on page 21
• Configure NeTS WCF Server on page 22

3.2.1 Basic Configuration in Configuration Manager

To perform a basic configuration of CMG Server, do the following:

1. Open CMG Configuration Manager.
2. If needed, set up new customer groups by expanding Site Configuration in the

sidebar and then clicking Customer Groups. Customer group (01) is created as
default group.

3. In the database, there is a default company with default settings installed. You can
edit the settings by expanding Site Configuration in the sidebar and then clicking
Companies/Views,Ext... You can, for example, edit and add the following:

• Name- The company name.

Note:

There can only be one company on one server.

• Servername - The CMG Server.

Note:

It is recommended that you use the static numerical IP address of the server.

• Views - Which customer groups that can be accessed when logged in to a certain
company view. Click the New button, select View and click OK. In the new window,
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enter the name of the view in the Name field and the customer groups in the
Customer group list field. Click OK when finished.

• Extensions- Extensions/number series that belong to the certain company. Click
the New… button, select Extension and click OK. In the new window, select a PBX
from the drop-down list and enter information in the Low number, High number
and Flash ICP fields. Click OK when finished.

• Enter the activity codes of your choice by expanding Site Configuration -
Diversions in the sidebar and then clicking PBX Codes. By clicking on the
check boxes by the flags, you get access to editing the activity codes of different
languages.

Note:

Consult your PBX partner to verify that the settings of the activity codes are
correct.

4. Enter new users in the CMG system. Expand Site Configuration in the sidebar and
then click All Users.

• Click New User to set up the account. Enter values in the Name, Password and
Fullname fields and click OK.

• Click Add Service to set the rights for the user. Select the appropriate service rights
and then click OK.

Note:

Integration with MX-ONE Provisioning Manager (user and extension
management application) requires a user account with permission to access
CMG Web Service Interface (CWI).

• Select Add User Viewsby expanding Site Configuration in the sidebar and then
clicking Companies/Views,Ext... Define what part of the database the user is
given.
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5. If desired, configure the possibility for CMG Web users to send requests to change
their user information. The Change Request function is configured using Configuration
Manager and Directory Manager. Do the following:

a. Open CMG Configuration Manager and expand CMG Web. Click Parameters
and do the following:

i. Make sure ChangeRequestMode is set to ENABLED.
ii. Define the path to the Visitor Service webservice, VisitorServicePath.

b. Open CMG Configuration Managerand expand CMG Web Components. Click
Parameters and do the following

i. Type the e-mail address for UpdMailTo to the directory administrator (or an
address to a group of administrators).

ii. Check that the path in the parameter UpdMailSavePath is correct.
iii. Create the corresponding folder for UpdMailSavePath at the path destination.

c. Open CMG Directory Manager and do the following:

i. In Settings, add a user with the same e-mail address as the administrator for
change requests specified in CMG Configuration Manager.

6. To configure subscriber image for InAttend with CMG usage. Do the following:

a. Open CMG Configuration Manager and expand CMG Web.
b. Click Parameters and do the following:

i. Verify/change image path in: LogicImageDir.
ii. Verify/change image file extension in: PictureFileExt.
iii. If the local web server is not used, set image path (url) in:Custom photo source

URL.
iv. To display profile picture, select ENABLED from the ShowImages drop-down

list.
7. For new parameters open CMG Configuration Manager and expand CMG Web.

Click Parameters and do the following:

a. Make sure Use live presence updates Linestate is set to ENABLED for medium
system with moderate requests. By default it is DISABLED.

b. Make sure Use live presence updates Visit is set to ENABLED, if Visit is used. By
default it is DISABLED.

c. Make sure Use live presence updates Voice Message is set to ENABLED, if
CMG Speech VM is used. By default it is DISABLED.

Document Version 1.0

13 CMG Configuration Guide



Configure CMG

3.2.2 Add an Application Pool

A classic .NET application pool is available for the CMG web services/ applications to
enable 32-bit applications on a 64-bit Windows Server.

The application pool is automatically added during installation and named "CMG 32
Classic", but there might be situations when it has to be re-added.

To add an application pool, do the following:

1. Open IIS Manager.
2. Expand your connection.
3. Click Application Pool…
4. Right-click Application Pools and select Add Application Pool.
5. In the Add Application Pool dialog box, do the following:

a. Name the application pool "CMG 32 Classic".
b. Set the .NET Framework version to 2.0.
c. Select Classic from the Managed pipeline mode drop-down list.

6. Click OK.
7. Select the newly created “CMG 32 Classic” and right-click and select Advanced

Settings from the drop down menu. Make sure the following is true:

a. .NET Framework Version is set to v2.0.
b. Enable 32-Bit Applications is set to True.
c. Managed Pipeline Mode is set to Classic.

8. Assign the CM, DM, Office, CWI, EPBXWS, and Personal Number web services/
applications to the new application pool. Do the following:

a. Right-click on the application name (for example CMGCM) and select Manage
application -> Advanced settings -> Application pool.

b. Select the newly created application pool in the scrollbar.

3.2.3 Configure BluStar Server Integration

BluStar Server integration settings are configured in CMG Configuration Manager. The
settings can be found in the BluStar Server part of the CMG Web, Parameters section.

To integrate with BluStar Directory Server, configure the following settings:

• BluStar Directory Server
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• BluStar Directory Base Path
• BluStar Directory Username
• BluStar Directory Password

To integrate with BluStar Presence Server, configure the following settings:

• BluStar Presence Server
• BluStar Presence Username

For descriptions of each setting, refer to Configuration Manager online help.

3.2.4 Configure AnA to Connect to External CMG Server

The default setting is to connect to the CMG database as "localhost", using the same
credentials that CMG CM/DM uses. If not default, web.config is configured so that the
AnA web service can connect to the CMG database server.

Do the following:

1. Open web.config in a text editor.
2. Change the value of the below parameter by replacing localhost with the new CMG

database server:<add key="DefaultDatabaseServer" value="localhost"/
>

3. Change the value of the following parameter from true to false:<add
key="FetchDbUsernamePassword" value="false"/>

3.2.5 Configure BluStar Presence Status

By default, the BluStar presence status function is disabled. To enable the function, do
the following:`

1. Open CMG Web web.config file in a text editor.
2. Edit the following parameter in the <appSettings> section, and set the value to

true:<add key="SetBluStarPresenceStatus" value="true"/>
3. Restart the web service.
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Note:

When BSW Service connects to BluStar Presence Server for SIP presence
subscriptions, the TCP protocol is used (UDP is not used).

3.2.6 Enable Click-to-Dial

The Click-to-Dial function allows a user to click on a telephone number in CMG Web to
call the number when using CMG Web with MiVoice MX-ONE.

Note:

The call back click-to-dial option cannot be used from a “forked extension” (i.e.
multiple terminals associated to the same number) in MiVoice MX-ONE. Recording of
personalized voice mail greeting phrases requires that Click-to-Dial is enabled.

To enable Click-to-Dial for CMG Web, do the following:

1. Open CMG Configuration Manager.
2. To enable Click to Dial, expand CMG Web in the sidebar and then click Parameters.

a. Type in the URL to the PBX.
b. Set ClickToDial to ENABLED.
c. Click the Save button.

3. To enable Click to dial for the PBX, expand Site configuration in the sidebar and then
click Parameters PBX:s & Flash clients.

a. Select the Click to Dial check-box in the PBX:s configuration to the right.
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Note:

Click-to-Dial is only valid for MiVoice MX-ONE, not for Mitel TSW.

b. Specify the host name in the Click to dial link field.
c. Enter account and password in the User Account and User Password fields.

Note:

The administration user (UserAccount) and password (UserPassword) fields are
not used when using MiVoice MX-ONE.

d. Define the prefixes for calling, in the fields:

i. External Prefix
ii. Abroad Prefix

e. Define the maximum number length for extensions in the Dial Prefix field.
f. Click the Save button.

4. Click to Dial must also be enabled for the users that should have this service. This is
done in CMG Directory Manager. Do the following:

a. Open CMG Directory Manager.
b. For each user, click the Settings tab and select the Click and dial check-box.
c. Click the Save button.

3.2.7 Configure which SMS Signature to use in Configuration
Manager

Configure the SMS signature function in Configuration Manager. Do the following:

1. Open CMG Configuration Manager and expand CMG Web.
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17 CMG Configuration Guide



Configure CMG

2. Click Parameters and do the following:

a. Set SMSAutoSign to ENABLED
b. Set SMS Signature Type to the chosen alternative:

i. Default (mobile)
ii. Extension

3. Click Save.

3.2.8 Enable Time Zone Functionality

There are two options for time zone handling in CMG:

• No time zone handling

Suitable only when all users are in the same place as the server.

• Time zone handling

CMG handles different time zones and daylight saving times. All time fields are
displayed and stored according to the time zone of the database server. If a CMG
database contains data for subscribers from more than one time zone, the time is
displayed according to the time zone of the client, but still stored according to the time
zone of the server. This applies to the CMG Quick, InAttend client, and to the CMG
Web application.

For example: If a Danish CMG Web user surfs from a PC with a regional setting for
the Danish time zone, he will get all time references in Danish time whether he looks
at his own CMG data or the data of a colleague in New Orleans.

Note:

• By default, the time zone in the InAttend client is set to the same time zone as the
server. See the InAttend user guides for information on how to change the time
zone.

• By default, the time zone in CMG Web is set to the same time zone as the server.
• The time zone in CMG DM is the same as for the server, and cannot be changed.

The following sections describe how to enable time zone functionality for the different
CMG applications.
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• CMG Web on page 19
• InAttend client on page 19

3.2.8.1 CMG Web

To enable Time Zone functionality for CMG Web, do the following:

1. Open CMG Configuration Manager.
2. Expand Site Configuration in the sidebar and click System Parameters.
3. Scroll to Time zone parameters. Do the following:

a. Set TimeZone to ENABLED.
b. Set TimeZoneAdv to ENABLED.
c. Set the TimeZoneId for the server. It is important that this time zone is the same as

on the used database server.

Note:

If you change the TimeZoneId, you need to restart NICESRV.

4. Click Save.
5. Restart CMG Web on all clients.
6. All users in CMG Directory Manager need to have their time zone defined. This is

done from Settings for each user in CMG Directory Manager.

Note:

Remember to specify time zone when adding new users.

Also remember to remove time zone value when disabling.

3.2.8.2 InAttend client

To enable Time Zone functionality for the InAttend client, do the following:
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1. Open Spman tool.

Note:

If any of the variables listed below does not exist, create it and set it to Enabled.

2. For the NICESRV process, set the ClientTimezone variable to Enabled. See the
example in the figure below.

3. For the NICESRV process, set AdvancedTZ to Enabled.
4. For the DBTOPBX process, set Timezone to Enabled.
5. For the PBXIR process, set Timezone to Enabled.
6. Save and restart the processes.

7. Restart InAttend client.
8. All users in CMG Directory Manager need to have their time zone defined. This is

done from Settings for each user in CMG Directory Manager.
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Note:

Remember to specify time zone when adding new users. Also, remember to
remove time zone value when disabling.

3.2.9 IIS configuration to access CMG CM, CMG DM and
CMG WEB applications over HTTPS

To access CMG CM and CMG DM Applications over https, do the following:

1. Create or import a server certification from the IIS server as shown in below
screenshot.

2. Go to Sites > Default Web Site.
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3. Click on Bindingsin the right-side pane and add a new https binding by choosing a
certificate created in the first step as shown in the below screenshot.

Note:

All the above settings are valid for CMG Web that you can access it over https.

3.2.10 Configure NeTS WCF Server

To record CMF Speech phrases from CMG Web, perform the following steps and make
the required configuration in NeTS.

1. Go to CMG CM > CMG Web > Parameters > Nets WCF Server, enter the NeTs
server IP address.

2. In the server where NeTS is installed, open the NeTs configuration tool.
3. In the NeTS tab, select the Enable NeTS Remoting API check-box.
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4. Enter the port number in the WCF TCP port field.

5. Log on to the CMG Web application and go to Preferences > Voice Service >
Phrases.

6. Enter a valid number to record a phrase and click Call.

7. Select any phrase that you want to record and click Record.
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Note:

The record button is enabled only if the call is made by entering the correct number in
step 6.

3.3 Backing up the CMG Database

The CMG setup program creates four backup jobs for backup and maintenance of the
CMG database. A backup job is scheduled to run every night at 1.00 AM. The five most
recent backups are kept and older backups are purged. The part of the registry where
the CMG system stores startup information is also backed up.

The backups are created as disk files in the SQL sub directory, for example:

C:\Program Files\Microsoft SQL Server\MSSQL10_50.MSSQLSERVER
\MSSQL\Backup\.

Note:

If you run SQL Express, you need to create the backup tasks manually since
scheduled tasks are not supported by SQL Express. Follow the procedure in section
3.1 to add the CMG SQL Express backup as a scheduled task.

3.4 Optimizing Nicesrv

Nicesrv is the process used by InAttend client for accessing the database. Optimization
of nicesrv is achieved using the following formula:

MaxThreads = NumberOfAttendants * 4

MinThreads = 0.75 * MaxThreads

Connections = MaxThreads

Open the Spman tool and set the NICESRV parameters:
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3.5 Configuring Advanced Security

You can set basic or advanced security for CMG users. Advanced security means that
higher standards can be set for users with regard to password quality, with the possibility,
for example, of locking them out after failing to log in.

Advanced security is managed in Configuration Manager, and the function is enabled
with the AdvancedSecurity parameter.

• User Management on page 25
• Security Parameters in Configuration Manager on page 26

3.5.1 User Management

The following is a summary of the advanced security settings for users:

• A user can be set to inactive or be deleted due to inactivity if the user has not logged
for a certain number of days.

• A user can be locked out of the system after a specified number of failed log in
attempts.

• An administrator can specify that a password never expires for a user.
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• An administrator can force a password change for a user in the following cases:

• After an account expiry
• At the next log in
• After account activation
• After an account has been unlocked

• An administrator can manage the settings for users and an administrator account can
never be deleted, locked out or expire.

3.5.2 Security Parameters in Configuration Manager

The following advanced security parameters can be set in CMG CM:

Security Parameter Description

AdvancedSecurity Set to Enabled to turn on the advanced security
functions. This means that the parameters below are
used.

DaysUntilLockout Number of days an account can be inactive before it
is locked. After that, the account is unlocked by the
administrator.

ForcePasswordChangeOnResetIf set to Enabled, the user must change the password
when the account is reset (i.e., activated after lockout
or inactivation).

DaysUntilDelete Number of days an account can be inactive before it is
deleted. A system account cannot be deleted.

MaxLogonErrors Number of failed login attempts before the account
is locked. A system account is permitted an infinite
number of login attempts.

PwdExpirationIntStd Number of days a user has to change the password,
before the password expires. A system account never
expires.
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Security Parameter Description

PwdExpirationIntAdm Number of days a Configuration Manager and
Directory Manager user has to change the password,
before it expires.

UserMustChangePwdFirstLogonIf set to Enabled, the user must change the password
when logging in for the first time.

MinPasswordLength Minimum number of characters in the password.

MinUserNameLength Minimum number of characters in the user name

PasswordRules If set to 0, all passwords with the required number of
characters are allowed.

If set to 1, the password can contain only
alphanumeric characters (a-z, 0-9), and at least one
character is numeric and one character is a letter.

3.6 Configuring EFS

Encrypting File System (EFS) is a feature that provides filesystem-level encryption.

It is recommended to enable EFS on the folders where the application log, trace files and
database backups are stored. This will ensure the prevention of unauthorized access.

You must run Nice server in service manager console using nice credentials. Nice
credentials can also have administrator privileges.

Encryption for CMG should be done with nice user account only.

For Reference of log files that needs to be encrypted – see Section 4.2 Log Directory for
each Component.
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3.7 Setting up Connection to the Telephony System (PBX)

There are different installation and configuration procedures for the communication
between a CMG Server and a PBX system.

• Connection to Cisco Call Manager Systems on page 28
• Connection to Other Systems on page 28

3.7.1 Connection to Cisco Call Manager Systems

To set up the connection to a Cisco Unified Communication Manager (CUCM) system,
please refer to Attendant Connectivity Server (ACS) documentation.

3.7.2 Connection to Other Systems

To set up the connection to another system than CUCM, see Appendix VI - Connecting to
the PBX.

3.8 Setting up Connection to the E-mail System

After establishing the connection between the PBX and the CMG system, you must set
up the connection to the e-mail system.

Supported e-mail systems are:

• IMAP (Internet Message Access Protocol)

To set up the connection to the e-mail system, see Appendix VII – Connecting to the E-
mail System.

3.9 Configuring MX-ONE Provisioning Manager Integration

When an organization unit is created or updated through the MX-ONE Provisioning
Manager system, PM sends the new information on to CMG so that the changes can
be reflected in the CMG system as well. For this to work, a number of parameters are
configured in the web.config file for CWI User Information service.

The parameters in the following table are implemented to support the MP integration:

Document Version 1.0

CMG Configuration Guide 28



Configure CMG

Parameter Value

CreateOrg Set this parameter value to “True” to create organization units that
do not exist in CMG.

DeleteOrg Set this parameter value to “True” to delete organization units that
not are in use.

AddAppNameOrg This parameter value indicates which application has created the
new organization unit, or updated an existing one.

To configure the MP integration, do the following:

Open a text editor and edit the file:C:\inetpub\wwwroot
\CMGUserInformationService\web.config

Add the parameters according to the example:

<appSettings>

...

...

<add key="CreateOrg" value="True"/>

<add key="DeleteOrg" value="True"/>

<add key="AddAppNameOrg" value="Created by MP"/>

...

...

</appSettings>
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3.10 Configuring Active Directory Synchronization

Configuration of Active Directory (AD) synchronization is performed using CMG CM. For
further information regarding CMG CM, see CMG – CMG Web Configuration Guide or
the built-in Help section.

• Information to Configure on page 30
• Deletion of Users on page 32
• Change of Synchronized Users in Active Directory on page 32
• ADSYNCCFG tool on page 32
• Mapping configuration for other fields from AD to CMG on page 34

3.10.1 Information to Configure

When configuration of the below parameters are completed please click on the “Save”
button. To activate the synchronization please mark the checkbox for “Activate” and click
on “Save” again.

The parameters are located in: CMG CM >> Active Directory Sync >> Parameters

Parameter Type Example Description

Address Field ADsrv.company.com Address of the AD directory

Port Field 389 Default port to access the AD
directory. Verify with the customer IT
department.

Username Field CmgAdSync Username to connect to AD (with
read rights)

Password Field ********** Password to the above user

Use TLS/
SSL

FALSE/
TRUE(Will
be
checkbox)

False Specifies whether SSL has to be
used or not to connect to AD
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Parameter Type Example Description

Activate FALSE/
TRUE(Will
be
checkbox)

False To enable or disable the AD
synchronization

Directory Field DC=Mitel,
DC=com

Path to retrieve users from AD

Prefix Field +468123 Prefix for internal number (i.e.
presence of the prefix in the number
identifies it as an internal number)

Extension
length 1

Field 5 Length of extension for internal
number (i.e. if number in E.164
format is +46812345678, internal
number is 45678)

PBX ID 2 Scrollbar 1 ID of PBX for every user who has an
internal number. This parameter can
be undefined. In this case, no PBX ID
is set for the user.

Msg sys ID Scrollbar 1 Message system number in CMG to
access e-mail address of the user
(i.e. to know where to store and
retrieve e-mail address of the user)

Poll Interval Field 5 Minimum interval between each
synchronization (in minutes)

1. If extension length is changed after the first synchronization (not typical), the phone
number of users already imported will not be changed, unless some data are changed
in AD for this user (which means that a new synchronization is performed). In this
case, the phone number is re-imported with the new extension length.

2. PBX ID is only set during the first synchronization (i.e., creation of the user in CMG
database). If PBX is changed in CMG database after this first synchronization, it is
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not changed if a new synchronization is performed on this user (synchronization is
performed if some data is changed in AD for this user).

3.10.2 Deletion of Users

For versions of CMG up to 8.5 SP3:

When a user is deleted in AD, it is not deleted in CMG, but it is rendered inactive.
Specifically:

• Phone number is removed from the Phone field in CMG
• PBX is set to None
• The checkbox for Main record is set to be un-marked
• All privileges (such as CMG Web user, Visit user, etc) are removed
• Calendar synchronization is disabled

For versions of CMG 8.5 SP4 and onward:

• If a user is deleted in AD, then it will be deleted in CMG as well(if not deleted, they will
copy CMG Web Directory Entry licenses.)

Note:

If an existing user in AD is removed in CMG, it will not be created in CMG again until:

• any data for the user is changed in AD
• the AD Synchronization service is restarted

3.10.3 Change of Synchronized Users in Active Directory

If an already synchronized user gets the TelePhoneNumber removed in AD, it is kept in
CMG. The same applies for mail addresses as well.

3.10.4 ADSYNCCFG tool

More fields can now be synchronized from AD to CMG with the ADSyncCfg tool

(\nicesrv\pgm\ADSyncCfg.exe).
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This tool creates a XML-file that ADSync Service uses.

The required parameters are:

1. Filter: LDAP filter filters the records that have to be synchronized.Example:
Company=Mitel, co=Sweden, co=se, co=dk (can also be empty).

2. Field in AD: The name of the field in AD.

Example: title, description, homePhone, pager, physicalDeliveryOfficeName.
3. Field in CMG: The name of the field in CMG.

Example: misc1, misc2…misc30, cordless, division, dep1, dep2.
4. InitOnly:

• If checked, synchronization will only be executed the first time ADSync runs and the
record is created in CMG.

• If unchecked, synchronization is executed every x minute.
• The interval is set in CMG CM ADSync Parameters.

Further configuration is done in CMG CM ADSync Parameters.

Document Version 1.0

33 CMG Configuration Guide



Configure CMG

3.10.5 Mapping configuration for other fields from AD to CMG

Note:

The easiest way to add or remove fields is to use the ADSyncCfg tool.

Editing the config file in Notepad (or similar) will not be reflected in the ADSyncCfg
tool. Only use Notepad, if more than 12 fields are going to be synchronized.

To synchronize other fields from AD to CMG predefined fields, update the config file:
%Program Files%\Mitel\ADSyncService\ADSyncConfiguration.xml as
below:

<ADSyncConfiguration filter="(|(co=sweden)(co=se)(co=dk))">

<Mapping AD="title" CMG="misc7" InitOnly="false"/>

<Mapping AD="description" CMG="misc19" InitOnly="false"/>

...

...

</ADSyncConfiguration>

PARAMETEREXAMPLE DESCRIPTION

Filter (|(co=sweden)(co=se)
(co=dk))

Filter specifies the conditions that have to be
met for a user to be sync from AD to CMG.
() is used to separate each filter.| is used for
OR condition between everyspecified filter.

AD Title Name of the field in the AD.

CMG misc7 Name of the field in CMG.
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InitOnly “true” or “false” true: the value of the AD mapping field
is only imported when you make the first
synchronization.

false: if the mapping field value is changed
in AD, then always synchronization is
performed and the value is changed in CMG.

To change the Log Level in AD Sync, edit:

%Program Files%\Mitel\ADSyncService\ADSyncService.exe.config

for AD Sync and update LogLevel:

<?xml version="1.0" encoding="utf-8"?>

<configuration>

...

<setting name="LogLevel" serializeAs="String">

<value>7</value>

</setting>

...

</configuration>

Valid values are 1, 2, 3, 4, 5, 6 and 7. If not set, the log level is set to 3.

3.11 Customize CMG Web

How to customize CMG Web with customer logo/pictures and text:

• The CMG Web images are stored on the web server and can be replaced by more
customized images.
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• The welcome title and text for CMG Web are changed in CMG CM.
• The directories names to search in, are also changed in CMG CM

Note:

Any change of the images must be approved by Mitel.

3.12 CUSTOMIZE CUSTOMER GROUP SEARCH

• INFORMATION TO CONFIGURE on page 36
• CUSTOMER GROUP SEARCH IN CMG WEB on page 38
• CMG Installation-Configuration on Azure on page 39

3.12.1 INFORMATION TO CONFIGURE

1. User can add more than one customer groups by selecting Customer groups tab
under Site Configuration in CMG CM.
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2. Enable Search all customer groups (Cust-grp) parameter under CMG Web -
Parameters in CMG CM.

3. Assign users to the Customer groups (Cust-grp) in CMG DM when the above
configuration is done as shown in the following figure.

4. Click Save.
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3.12.2 CUSTOMER GROUP SEARCH IN CMG WEB

1. If Search all customer groups parameter in CMG CM is enabled, then the customer
groups list is shown in CMG Web as shown in the following figure.

Note:

The All option only gets displayed when the Search all customer group
parameter is enabled.

2. Select a Customer group from the drop-down list and search for the desired users.
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3. If you select All as an option, then you can able to see all the added/existing users
irrespective of Customer groups assigned.

Note:

If Search all customer groups parameter is disabled in CMG CM, then Customer
group search option is not visible in CMG Web. The searches are done against
currently logged in user’s customer group.

3.12.3 CMG Installation-Configuration on Azure

1. Log in to the Azure portal.
2. Go to the Resource group and click Add to create a virtual

machine.
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3. Choose any Windows server version; for example, Windows Server

2016.
4. Provide all the necessary details as shown in the following screen

capture.
5. Select the review+create tab. The virtual machine is created.
6. Go to Networking and check the Network Interface

details.
7. Go to IP configurations and provide the static IP

address.
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8. After the IP address is assigned, use remote desktop and start CMG installation and
configuration. Refer to CMG documentation for CMG installation and configuration for
details.

3.13 Setting up CMG Web for Visual Voicemail in the MiCollab
Client

Before you Begin

Before you can set up CMG Web for Visual Voicemail in the MiCollab Client, CMG Web
must be enabled for HTTPS and the value of the HTMLAudioControlPlay setting in the
Web.MiCollab.config file must be set to true. If it is not possible to do these in the existing
CMG Web, create a new website for MiCollab’s usage.

Note:
If the MiCollab application is accessible from the internet (Teleworker), the CMG Web
must be accessible from internet as well, otherwise this will only be accessible in LAN
mode.

Procedure

To set up CMG Web for Visual Voicemail in the MiCollab Client:

1. Edit the Web.MiCollab.config file in the (C:\inetpub\wwwroot\CMGWeb) location.
2. Update MiCollabFQDN and CMGWebFQDN (in two places) to the MiCollab server

FQDN and the CMGWeb server FQDN.
3. Copy or rename the Web.MiCollab.config to Web.config on C:\inetpub\wwwroot

\CMGWeb.
4. Log in to the Server Manager Configuration panel for the MiCollab application.
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5. Go to Applications > MiCollab Client Service > MiCollab Client Service
Configuration.

6. Select MiCollab Advanced Messaging as Voice mail server type.
7. Enter the URL for the CMG website in the MiCollab AM URL field.

Example: (CMGWEBSERVERFQDN/CMGWeb/messages/). The MiCollab Client by
default prepends HTTPS:// to the URL.

Note:
Using Click to Callfrom the embedded CMGWeb in the client is not supported but
you can copy the number to the client.
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3.14 Configuring Universal Search in BlueStarWebService
Config.xml

To enable universal search in CMGWebService, open and edit
BluStarWebServiceConfig.xml as shown below:

<UniversalSearchEnabled>true</UniversalSearchEnabled> 
    
<!-- 
    Here set which fields should be included in the index.      
  
    Note that that might be different fields than later shown in
 the search-result-view.
    For instance department name, or misc19 might be used for
 find search-results, but not being shown fields.
    Exclude misc fields with sensitive or private data, an
 example can be misc10 
    For cases like that the search results might seem unexpected
 to users. 
    Choose what suits the customer.
-->

    <!-- Uncomment misc and specify which misc-fields to search
 in, separated by comma.  Otherwise no misc-fields are searched
 --> 
        <!-- <misc> 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12, 13,
 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29.
 30 </misc>  --> 
</UniversalSearchFilter>  
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This chapter contains the following sections:

• Configuring CMG Server SQL Express Backup
• Configuring Mitel LDAP Server for CMG
• Configuring IP Phone Services for Cisco
• Configuring CMG Corporate Directory for IP Phones
• Configuring CMG Personal Number Interface

4.1 Configuring CMG Server SQL Express Backup

If you run SQL Express, you must create the backup tasks manually since scheduled
tasks are not supported.

To add the CMG SQL Express backup as a scheduled task, do the following:

Note:

The screenshot examples below are from Windows 2008.
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1. Open Task Scheduler.

The Task Scheduler window is displayed:

In the Task Scheduler (Local) column to the right, click Create Basic Task…
2. In the Create a Basic Task dialog, do the following:

a. Type a name for the task. Then click Next.
b. In the Task Trigger dialog, select how often you want the task to be performed (for

example Daily). Then click Next.
c. In the Daily dialog, select the time and day the task should run, and click Next.
d. In the Action dialog, select Start a program, and click Next.
e. In the Start a program dialog, click Browse….
f. In the Open dialog, select the file CMGExpressBackup.cmd and click Open to

return to the Start a program dialog. Then click Next.
g. In the Finish dialog, select Open the Properties dialog for this task when I click

Finish. Then click Finish.
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3. The Backup Properties dialog is now displayed:

a. Click the button Change User or Group… to select the user to run this job. This
user has to be Local Administrator.

b. Select Run whether user is logged on or not.
c. Select the correct Windows Server version in the Configure for: list.
d. Click OK.
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4. The Task Scheduler dialog is displayed:

Enter the user’s password. Click OK.

The job has now been created in Task Scheduler Library:

4.2 Configuring Mitel LDAP Server for CMG

• Enable LDAP Server on page 48
• Configure LDAP Server on page 48
• Configuration on page 49
• Database on page 49
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• SQL/CMG Login Information on page 50
• New Country on page 51
• Logging on page 52
• General on page 52
• Menu: File - Change Path to LDAP Server on page 53

4.2.1 Enable LDAP Server

The LDAP server is enabled and disabled for CMG in CMG Configuration Manager.

To activate the import of the data to the LDAP server, expand Site Configuration in the
sidebar and click System Parameters. The System parameters page is displayed:

Set LDAP to ENABLED.

4.2.2 Configure LDAP Server

The LDAP Server is administered using the TsLdap Administrator tool. The configuration
settings for this tool are stored in the TsLdapAdmin.ini file in the Windows directory.

1. Open TsLdapAdministrator. The main window is displayed:

2. Follow the instructions in the coming sections in order to configure the different parts
of TsLdap Administrator.
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4.2.3 Configuration

The slapd.conf file contains the configuration of the Mitel LDAP Server.

In the Configuration section of the TsLdap Administrator GUI, click Load
Configuration to load the current settings of the LDAP Server.

Save the current configuration by clicking Save Configuration.

4.2.4 Database

In the Database section, it is possible to configure the following:

• Attributes - the attributes of the LDAP Server
• Backend settings - the connection to the CMG database (NICE)
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• Change country code - the country code of the LDAP Server

See the coming sections for further descriptions.

• Custom Attributes on page 50

4.2.4.1 Custom Attributes

Custom attributes can be added when needed.

Note:

Attributes configured in the CMG table ldap_attr_mappings (for mapping CMG
fields to LDAP attributes) must also be configured in the LDAP Server.

Click the Advanced… button to show the already existing built-in attributes of the LDAP
Server.

4.2.5 SQL/CMG Login Information

The LDAP Server connects to the CMG database using ODBC to retrieve the data
through the SQL Backend. The initial configuration for the access to the database is
configured during the setup of the LDAP Server.
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User: Authorized user to access the CMG database NICE.

Password: Password of the authorized user.

ODBC data source: Name of the ODBC data source used for the connection.

Note:

The data source has to be configured using the Control Panel.

4.2.6 New Country

Click the Change country code button to change the current country. After the
installation, the country code is configured to com in the LDAP Server and in the CMG
database.
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Note:

After changing the country code in the LDAP Server, the configured value has to be
changed in the CMG table LDAP_config.

4.2.7 Logging

In the Loggingsection, you can activate and configure the LDAP Server logging function.
The log files can be found in the log subfolder under the program directory of the LDAP
Server.

More logging can be found in the SQL LDAP_messages table, which contains
messages pointing to inconsistencies in the NICE database.

This table is populated by sp_LDAP_checkDatabase. Messages older than 30 days
are deleted/updated when sp_LDAP_fillLDAPEntries is executed.

4.2.8 General

In the General section, the following can be configured:

• Current country code - The country code com results in a default search base
c=com to access the data of the LDAP Server.

• Port number - It is possible to reconfigure the port number used to access the Server.
By default the LDAP Server access TCP port is 389.
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Note:

If using a firewall, the LDAP TCP port has to be opened.

• Size limit of search – This is the maximum number of entries that is returned on a
single search request (maximum is 10 000).

4.2.9 Menu: File - Change Path to LDAP Server

The File - Change path to LDAP Server menu allows you to change the path to the
LDAP Server.

4.3 Configuring IP Phone Services for Cisco

Cisco Call Manager and Cisco IP Phone services are configured in Cisco Unified CM
Administration (https://<Cisco server name>/ccmadmin).

• Cisco Call Manager Configuration on page 53
• Cisco IP Phone Services Configuration on page 54
• CMG System Configuration on page 54

4.3.1 Cisco Call Manager Configuration

1. Open Cisco Unified CM Administration.
2. Navigate to the Cisco IP Phone Services Configuration section in Call Manager

Administration.
3. Add the CMG Activity Service:

a. In the Service Name field, add the name CMG ACTIVITY.
b. In the Service URL field, add the URL you created during installation. For example:
http://<CMG_Server_name>/cmgoffice/ipphoneservice/start.asp
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4. Add the CMG Directory Service:

a. In the Service Name field, add the name CMG DIRECTORY.
b. In the Service URL field, add the URL you created during installation. For

example: http://<CMG_Server_name>/cmgoffice/ipphoneservice/
searchmenu.asp

4.3.2 Cisco IP Phone Services Configuration

Open Cisco Unified CM Administration and define and maintain the list of Cisco IP
Phone Services to which users can subscribe at their site.

Users can then log on to the Cisco Call Manager User Preferences panel and subscribe
to these services for their Cisco IP phones.

For more information, see to the help section in Cisco Unified CM Administration.

4.3.3 CMG System Configuration

Configure IP Phone Services from CMG Configuration Manager.

1. Open CMG Configuration Manager.
2. Expand CMG Web Components and select Parameters.
3. Set the DefLanguage parameter to the chosen language.
4. For the CMGIpPhonePath parameter, point at the destination folder where IP Phone

Service is installed.
5. Set the CiscoIpPhone parameter to ENABLED.
6. Click Save.

4.4 Configuring CMG Corporate Directory for IP Phones

This section describes how to configure the different IP phones to function with the
Corporate Directory application. This section also describes how to configure localization
files.

• Configure Localized Resource Files in Microsoft IIS on page 55
• CMG Connection Settings and Dialing Plan on page 58
• IP Phones Configuration on page 61
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• Configure Prefix for Multi Node Configuration on page 65

4.4.1 Configure Localized Resource Files in Microsoft IIS

For Mitel 7400 and MiVoice 4400 phones.

• Configure application settings in IIS on page 55
• Configure language settings on page 56
• Verify the settings on page 56

4.4.1.1 Configure application settings in IIS

To configure the ASP.NET application settings with IIS 7.0, do the following:

1. Open IIS Manager.
2. Select CorpDir web site.

a. Right-click ASP.NET/Application setting and select Open Feature.
b. Use Add or Edit to match the configuration at your site.

Key Value

cmg_server The name or IP address of the CMG directory server.

cmg_port The port number configured for the web server where the CMG CWI
web service is running.

cmg_user The name of the CMG user account that is used to search the
directory.

Note! The user must have the CMG Web User Interface enabled.

cmg_password The password for the CMG user account that is used to search the
directory.

cmg_results The maximum number of results shown on the telephone.

Note! If set too high, a buffer overrun error occurs in the phone
browser.
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4.4.1.2 Configure language settings

Localized resource files are installed in the CorpDir/App_GlobalResources folder
on the web server. Additional translated resource files can be copied to this folder.
Localized resource files have to be named according to the following naming convention:
Translation.<locale>.resx.

Example: The Swedish localized resource file is named Translation.sv-se.resx

To change the language being used, do the following:

1. Open IIS Manager.
2. Select the ASP.NET tab in CorpDir Properties.
3. Click Edit Configuration…
4. Select the Application tab.

Select the desired language in the Culture and UI culture drop-down list.For example:
For Swedish, select sv-SE.

4.4.1.3 Verify the settings

Start Internet Explorer and type http://localhost/CorpDir/default.aspx in the Address bar:

Document Version 1.0

CMG Configuration Guide 56

http://localhost/CorpDir/default.aspx


Configure Optional Server Software

Type a name you know exists in the directory and click Search:

If correctly configured, the Search Result page is shown.
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4.4.2 CMG Connection Settings and Dialing Plan

For Mitel 67xxi, 68xx, 69xx, and SIP-DECT phones.

• CMG connection settings on page 58
• Configuring dialing plan on page 59
• Configuring language settings on page 59
• Enabling logging on page 60
• Verifying settings on page 61

4.4.2.1 CMG connection settings

To configure CMG connection settings, do the following:

1. Open the file CorpDir\xml\config\cmg_directory.conf in Notepad.
2. Edit the parameters in section [CMG_Server]to match the configuration at your site:

Parameter Value

hostname The server name or IP address of the CMG directory server.

port The port number configured for the web server where the CMG CWI
web service is running.

username The name of the CMG user account that is used to search the
directory.

Note! The user must have the CMG Web User Interface enabled.

password The password for the CMG user account that is used to search the
directory.

cmg_results The maximum number of results shown on the phone.Note! If set too
high, a buffer overrun error occurs in the phone browser.
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4.4.2.2 Configuring dialing plan

To configure a dialing plan, do the following:

1. Open the file CorpDir\xml\config\cmg_directory.conf in Notepad.
2. Edit the parameters in section [Dialplan] to match the configuration at your site:

Parameter Value

countrycode Country code.

If phone number starts with "+<countrycode>", this is removed.

international International Dialing Code.This prefix replaces the + sign in the
dialing strings.

longdistance Long distance prefix. This prefix is added to the number in case own
country code (+<countrycode>) has been removed.

outgoing Outgoing prefix (trunk access code).Prefix that has to be appended
for outgoing calls (all call but local calls), for example 0 or 9.

local List of local PBX number prefixes separated by a comma (in
national format). Prefix is removed no outgoing prefix is added.
Examples:

local=905760,978262

--> 9057602222 are replaced by 2222

--> 9782623333 is replaced by 3333.

localextlen Internal number length. Numbers with this number of digits or less
are treated as local PBX extensions. No prefix added.

4.4.2.3 Configuring language settings

Directory Search uses the configured input language as the phone’s Screen language.
You can force another specific language for the whole system by doing the following:
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1. Open the file CorpDir\xml\config\server.conf in Notepad.
2. Edit the Language parameter.

This parameter can, for example, be set to en for English, fr for French, and es for
Spanish.

The actual translated strings are kept in the language.ini file, stored on the web
server in the folder named CorpDir\xml. In this file, translations for each text string
used in the application are stored. Example:

[Name or Phone:]

en=Name or Phone:

fr=Nom ou Téléphone:

de=Name oder Nummer:

es=Nombre o Teléfono:

pt=Nome ou Telefon:

sv=Namn eller telefon:

fi=Nimi tai numero:

no=Navn eller telefon:

da=Navn eller Telefon:

it=Nome o Telefono:nl=Naam of Telefoonnr:

Additional translations can be added to this file when needed.

4.4.2.4 Enabling logging

If required, logging can be enabled by setting the parameter trace to 1 in the file:
CorpDir\xml\config\server.conf
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The default location of the log files is: CorpDir\xml\log

A new log file is created every day and the file name is <date>.log, where date is in the
format: mmddyy.

4.4.2.5 Verifying settings

Start Internet Explorer and go to http://localhost/xml/directory/
CorpDir.php

If correctly configured, the web server returns an XML structure as shown above.

4.4.3 IP Phones Configuration

This section describes how to configure the IP phones to function with the Corporate
Directory application.

• MiVoice 4425 phones on page 61
• Mitel 7400 phones (End Of Life) on page 62
• Mitel 67xxi SIP phones on page 63
• Mitel SIP-DECT 3.0 on page 63
• Mitel SIP-DECT 3.1 on page 64

4.4.3.1 MiVoice 4425 phones

Enabling menu on the phone

To enable the CorpDirectory menu item on the IP phone to load the Corporate
Directory application, the configuration file for DBC42x IP phone has to be changed. The
configuration file is d42x02-config.txt and it is stored in the dbc42x02 directory on
the IP Phone Software Server.
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You must set the DirectoryAddress parameter (under the [WAP] section) to the IP
address of the web server where the Corporate Directory is installed and the path to the
.aspx file.

Example: If the web server is running on a server with IP address 192.168.1.10 then the
parameter has to be set as:

DirectoryAddress=http://192.168.1.10/CorpDir/d4/d4.aspx

There are additional parameters that has to be set in the configuration file. For more
detailed information, see the description for Configuration File for DBC 42x and
Installation Instructions for DBC 425 in the CPI for MiVoice MX-ONE.

Configure number translation

Number translation settings can also be configured under the [WAP] section of the
d42x02-config.txt file, see description for Configuration File for DBC 42x in the CPI
for MiVoice MX-ONE.

4.4.3.2 Mitel 7400 phones (End Of Life)

Enabling menu on the phone

• Mitel 7433 and 7434 terminals:

To enable the Corporate Directory application in the Contacts menu, the configuration file
for DBC43x IP phone has to be edited. The configuration file is d43x01-config.txt
and it is stored in the dbc43x01 directory on the IP Phone Software Server.

You must set the DirectoryAddress parameter (under the [WEBBrowser] section) to
the IP address of the web server where the Corporate Directory is installed and the path
to the.aspx file.

Example: If the web server is running on a server with IP address 192.168.1.10 then the
parameter has to be set as:

DirectoryAddress=http://192.168.1.10/CorpDir/d4/d4.aspx

There are additional parameters that has to be set in the configuration file. For more
detailed information, see the description for Configuration File for DBC 43x and DBC44x
and Installation Instructions for DBC 43x and DBC 44x in the CPI for MiVoice MX-ONE.

• Mitel 7444 and 7446 terminals:

To enable the Corporate Directory application in the Contacts menu, the configuration file
for DBC44x IP phone has to be edited. The configuration file is d44x01-config.txt
and is stored in the dbc44x01 directory on the IP Phone Software Server.

Document Version 1.0

CMG Configuration Guide 62



Configure Optional Server Software

The parameter to be changed is located under the [WEBBrowser] section and is
dependent on the phone model. This parameter can be set to the IP address of the web
server where the Corporate Directory is installed and the path to the .aspx file.

Example: If the web server is running on a server with IP address 192.168.1.10 then the
parameter can be set as:

http://192.168.1.10/CorpDir/d4/d4.aspx

There are additional parameters that has to be set in the configuration file. For more
detailed information, see the description for Configuration File for DBC 43x and DBC 44x
and Installation Instructions for DBC 43x and DBC 44x in the CPI for MiVoice MX-ONE.

Configure number translation

Number translation settings can also be configured under the [WAP] section of
the d43x02-config.txt and d44x02-config.txt files, see description for
Configuration File for DBC 42x in the CPI for MiVoice MX-ONE.

4.4.3.3 Mitel 67xxi SIP phones

To set the Corporate Directory application to one of the function keys, one of the
configuration files has to be updated. Normally, it is the model-specific configuration file
that has to be edited.

Example: If the web server is running on a server with IP address 192.168.1.10 and the
wish is to put a Corporate Directory button on the soft key 6, the parameters can be set
as:

softkey6 label: Corp Dir

softkey6 value: http://192.168.1.10/xml/directory/CorpDir.php

4.4.3.4 Mitel SIP-DECT 3.0

Within SIP-DECT 3.0, the Corporate Directory for IP Phone can be used as XML
Application when the handset is in idle state. This requires adding the Corporate
Directory for IP Phone as XML application in the OMM using OMP.

Connect to the OMM using OMP and go to Configuration > System features > XML
Applications.
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Configure a new XML application

Create:

Name: CorpDir

Protocol: HTTP

Server: <IP address of CMG Server>

Path: /xml/directory/CorpDir.php

To access CMG with a 600c/d handsetuse 
> Applications > CorpDir or create a softkey
to link to this application 

4.4.3.5 Mitel SIP-DECT 3.1

SIP-DECT 3.1 supports XML directories. The handset can access the directory in idle or
call state using the Directory  function. (e.g. Key Up: , within call /dial state).

This requires adding Corporate Directory for IP Phone as XML directory in the OMM
using OMP. Connect to the OMM using OMP or Web service and System features >
Directory.

Configure a new directory entry

Create:

Type: XML

Name: CorpDir

Protocol: HTTP

Server: <IP address of CMG Server>

Path: /xml/directory/CorpDir.php

To access the CMG directory with a
600c/d handset, use the built in central
directory functions and softkeys.

media/image47.png
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4.4.4 Configure Prefix for Multi Node Configuration

If the PBX system includes multiple nodes, prefixes have to be specified in order to setup
calls between the different PBXs through the Corporate Directory application.

• Configuration of CMGUserInformationService (CWI) on page 65
• Configuration of Corporate Directory application on page 67

4.4.4.1 Configuration of CMGUserInformationService
(CWI)

The CWI specific information is configured in the web.config file.

Parameter Value

PrefixAdd If prefix is used, set this parameter to value “True”

PrefixMaxExtLen The maximum length of the internal number. A value of 5
means that the prefix is added for internal numbers containing a
maximum of 5 digits.

PrefixExternal The outgoing prefix (trunk access code) that has to be appended
for external calls (all calls but local calls), for example 0 or 9.

PrefixInternational The international Dialing Code, for example, 00.This prefix
replaces the + sign in the dialing strings.

To configure multi node configurations, do the following:

1. Open a text editor and edit the file:C:\inetpub\wwwroot
\CMGUserInformationService\web.config
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2. Add the parameters according to the example:

<appSettings>

<add key="CMGUserInformationService.theAnAComputer.AnA" 

value="http://localhost/NwAnA/AnaService.asmx"/>

<add key="CMGversion" value="75"/>

<add key="LoginModeWindows" value="True"/>

<add key="LocalDBNoAnA" value="False"/>

<add key="ValidateAnAToken" value="False"/>

<add key="PrefixAdd" value="True"/>

<add key="PrefixMaxExtLen" value="5"/>

<add key="PrefixExternal" value="0"/>

<add key="PrefixInternational" value="00"/>

<add key="TraceLevel" value="0"/>

</appSettings>

Note:

If the PBXs are configured with different extension length, the PrefixMaxExtLen
parameter has to be configured with the maximum extension length in the PBX
network.
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4.4.4.2 Configuration of Corporate Directory application

The value for localextlen has to set to a high value, for example “99”, to disable the built-
in logic for local numbers.

See section 3.4.2.2 for more information about the localextlen parameter.

4.5 Configuring CMG Personal Number Interface

• Configuration in MX-ONE Provisioning Manager on page 67
• Enable CMG Personal Number in CMG Configuration Manager on page 69
• Enable CMG Personal Number in CMG Directory Manager on page 70
• Add Parameters to the PBXSTDNIU Process for TSW/MX-ONE on page 71
• Forwarding Personal Number PRoFILES– General Information on page 71

4.5.1 Configuration in MX-ONE Provisioning Manager

For more information, refer to the Provisioning Manager documentation.

• Create a User on page 67
• Add User to the Administrator Group on page 68

4.5.1.1 Create a User

1. Start Provisioning Manager.
2. Click Users and then User. On the User page, click Add.

On the Add User - step 1/3 page, fill in the fields: Last Name and User ID, of the
user.

A password is optional (minimum 6 characters).
3. Select one or more options in the list Existing Department(s); Location(s) and

click on the right-arrow. The selected option appears under Selected Department(s)
Location(s). When finished click Next.

4. On the User - Add - step 2/3 page,

click the tab Service Summary to add an IP extension.
5. Click Add to the right of the field Add New Extension.
6. On the Extension - Add - step 1 / 2 page,

select IP from the Extension Type list and click Next.
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7. On the Extension - Add - step 2 / 2 page, select whether the user allows dialing
internal, regional, national or international phone calls, from the Common Service
Profile list.

Note:

This depends on how the system was configured in the startup.

8. Click Continue.
9. On the User - Change page, click Apply and on the next page click Done.

4.5.1.2 Add User to the Administrator Group

1. Start Provisioning Manager.
2. Click Administrators and then Administrator tab.
3. On the Administrator page, click Add and choose a User.

a. Assign User to: - a pre-defined Security Profile (with Manage/View User Data).

- Department(s): All

- Locations(s): All
b. Click Apply and on the next page click Done.
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4.5.2 Enable CMG Personal Number in CMG Configuration
Manager

To turn on this function in CMG, do the following:

1. Open CMG Configuration Manager.
2. Expand Site Configurationand select PBX:s & Flash clients.
3. Set the following PBX variables:

• Individual ICP: Enabled
• Personal number: Enabled
• PBX version (MiVoice MX-ONE or Mitel TSW)
• IP address (to the PBX)
• IP port (PBX port)
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Note:

For MiVoice MX-ONE use port 80.

For Mitel TSW use port 23.

• Node user
• Node password

4. Expand CMG Web Components and select Parameters.

a. In the Enable/Disable functions section, set PersonalNumberMode to
ENABLED.

b. In the Personal number parameters section, set the following:

i. CMGServerAddress: The IP address to the CMG Server.
ii. PNConfigUrl: The URL to the personal number configuration directory.

c. Click Save.

4.5.3 Enable CMG Personal Number in CMG Directory
Manager

1. Open CMG Directory Manager.
2. Click the Settings tab and enable Personal number for the users that shall use the

Personal Number function.
3. Click Save.
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4.5.4 Add Parameters to the PBXSTDNIU Process for TSW/
MX-ONE

1. Open the Spman tool and set the PBXSTDNIU parameters:

2. Set the following parameters:

PNUrl: The CMG Server IP address and the web service URL, example; http://
<CMG_Server_IP_address>/epbxws/epbxws.asmx

PNWaitForStatus: Enabled

FallbackPNProfile: 1

If a variable does not exist, create it and set it to the relevant value.
3. Click Save and restart the process.

4.5.5 Forwarding Personal Number PRoFILES– General
Information

1. To display the Personal Number profiles in CMG Web to users, go to CMG CM > CMG
Web > Parameters and set the parameter PersonalNumberMode to ENABLED.
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2. To set the Personal Number profiles, go to CMG Web > Preferences > Call Routing
Profiles > Personal Number – Forwarding Profiles.

3. You cannot remove the first profile (profile1) from CMG Web. You can remove it only in
the MX-ONE PBX or through the phone. (However, you can remove the other profiles
in CMG Web.)

4. If you have only one profile (profile1) then it will be the active one. You cannot de-
activate it in CMG Web. It can be de-activated only in the MX-ONE PBX or through the
phone.

5. Use the Active radio button to alter the active state of profiles. Using this button, you
can choose the profile that you would want to be the active profile.

Note:

The Personal Number - Forwarding Profiles field now list upto 10 profiles.



Logging 5
This chapter contains the following sections:

• Log Levels
• Log Directory for each Component

All components in CMG have log files for troubleshooting.

Make sure that enough hard drive space is available, as there is no size limiter (except for
number of days) for the logging. This could, in extreme cases on servers with a small C:drive,
fill up the hard drive. For example, the individual log files for CMG Web Service can reach 900
MB in size each.

5.1 Log Levels

The log levels are set in the Registry. The levels are from lowest level (Error) to highest
(Debug). The higher log level the more information is written to the log file.

Log Level
REGISTRY
Value Description

Error 0 Error logs are written when errors occur.

Warnings 1 Warning logs are written when the system diverges from
normal behaviour.

Info 2 Info logs are written for normal events in the system.This is
the default log level for customer site installations.

Trace 3 Detailed logs but without extra data output needed for
debugging.

Debug 4,5,6 or 7 The most detailed log level. Logs debug data.
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5.2 Log Directory for each Component

This section describes where find the log files for each component.

On new installations, the default log directory starts with:

C:\ProgramData\Mitel\...

C:\Program Files (x86)\Mitel\...

On upgraded system, the default log directory starts with:

C:\ProgramData\Aastra\...

C:\ProgramData\Netwise\...

C:\Program Files (x86)\Aastra\...

• Default software on page 74
• Optional software on page 76

5.2.1 Default software

• AnA Web Service on page 74
• BluStar License Manager on page 75
• CMG Web and CMG Web Service on page 75
• Calendar Connection on page 75
• CMG Activity Information Service (CWI) on page 75
• CMG Configuration manager and Directory Manager on page 75
• CMG Office Web Components on page 76
• CMG Server on page 76
• CMG User Information Service (CWI) on page 76
• Enterprise License Manager (Server and Client) on page 76

5.2.1.1 AnA Web Service

The default log directory for Ana Web Service:

C:\nicesrv\log
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5.2.1.2 BluStar License Manager

The default log directory for BluStar License Manager is:

C:\Program Files (x86)\Mitel\BluStarLicensemanager\

5.2.1.3 CMG Web and CMG Web Service

The default log directories for BSW Web respective BSW Service are:

C:\ProgramData\Mitel\CMGWeb.Web\

C:\ProgramData\Mitel\CMGWeb.Service

Change of log level (1-7, default 3) for CMG Web Service:

C:\Program Files (x86)\Mitel\CMGWebService
\CMGWebServiceConfig.xml

5.2.1.4 Calendar Connection

The default log directory for Calendar Connection is:

C:\Program Files (x86)\Aastra\Calendar Connection\Default\logs

5.2.1.5 CMG Activity Information Service (CWI)

The default log directory for CMG Activity Information Server is:

C:\nicesrv\log

5.2.1.6 CMG Configuration manager and Directory
Manager

The default log directory for CMG CM and CMG DM is:

C:\nicesrv\log
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5.2.1.7 CMG Office Web Components

The default log directory for CMG Office Web Components is:

C:\nicesrv\log

5.2.1.8 CMG Server

The default log directory for CMG Server is:

C:\nicesrv\log

5.2.1.9 CMG User Information Service (CWI)

The default log directory for CMG User Information Service is:

C:\nicesrv\log

5.2.1.10 Enterprise License Manager (Server and Client)

The default log directory for ELM server and client is:

C:\Program Files (x86)\Mitel\License Manager\log

5.2.2 Optional software

• Optional - CMG Quick (client) on page 77
• Optional - BluStar Server and BluStar Presence Server on page 77
• Optional - CMG AD Sync on page 77
• Optional - CMG Corporate Directory for IP phone on page 77
• Optional - CMG IP Phone Services for Cisco on page 77
• Optional - CMG Personal Number Interface on page 78
• Optional - CMG Server SQL Express backup on page 78
• Optional - LSSCom Client Standalone on page 78
• Optional - Mitel LDAP Server on page 78
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5.2.2.1 Optional - CMG Quick (client)

The default log directory for CMG Quick (client) is:

%LOCALAPPDATA%\Mitel\BluStarQuick

5.2.2.2 Optional - BluStar Server and BluStar Presence
Server

The default log directory for BluStar Server is:

C:\Program Files (x86)\Mitel\BluStar Server\Trace

The default log directories for BluStar Presence Server are:

C:\Program Files (x86)\Mitel\BluStar Server\Trace\PresenceServer

C:\Program Files (x86)\Mitel\BluStar Server\PresenceServer\logs

5.2.2.3 Optional - CMG AD Sync

The default log directory for CMG AD Sync is:

C:\ProgramData\Mitel\ADSync\

5.2.2.4 Optional - CMG Corporate Directory for IP phone

The default log directory for CMG Corporate Directory for IP Phone is:

C:\Program Files (x86)\Aastra\CorpDir

5.2.2.5 Optional - CMG IP Phone Services for Cisco

The default log directory for CMG IP Phone Services for Cisco is:

C:\nicesrv\log
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5.2.2.6 Optional - CMG Personal Number Interface

The default log directory for CMG Personal Number Interface is:

C:\Program Files (x86)\Aastra\PersonalNumber\EPBXWS\Log

5.2.2.7 Optional - CMG Server SQL Express backup

The default log directory for CMG Server SQL Express Backup is:

C:\Program Files\Microsoft SQL Server\MSSQL11.MSSQLSERVER\MSSQL
\Backup

5.2.2.8 Optional - LSSCom Client Standalone

The default log directory for LSSCom Client Standalone is:

C:\Program Files (x86)\Aastra\CfgAgent\Logs\CfgAgent_YYMMDD.log

5.2.2.9 Optional - Mitel LDAP Server

The default log directory for Mitel LDAP Server:

C:\Program Files (x86)\Mitel\TSLDAP\log



Troubleshooting 6
This chapter contains the following sections:

• Enterprise License Manager (ELM)
• CMG Web Trace Level
• Microsoft ODBC Drivers
• Microsoft Windows Server OS

This section describes what kind of information that is useful and has to be kept ready when
troubleshooting the CMG Server applications.

6.1 Enterprise License Manager (ELM)

The ELM setup contains software for both Server and Client (if required).

• ELM Client Installation on page 79
• ELM Server Installation on page 79

6.1.1 ELM Client Installation

Note:

If BluStar License Manager and ELM Server are installed on separate servers, the
ELM Client has to be installed on the same server as BluStar License Manager.

6.1.2 ELM Server Installation

When installing ELM on a Windows 2012 R2 server, the following error may occur:
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To correct this error, make sure that the following boxes are checked in Windows
2012 Server Manager -> Manage -> Add Roles and Features -> Web Server ->
Management Tools

If the error remains, please contact the Mitel Support.

6.2 CMG Web Trace Level

A new appSetting must manually be added to change the log level in CMG Web. Edit
\inetpub\wwwroot\CMGWeb\web.config for CMG Web and add the appSetting
LogLevel.
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<appSettings>

...

...

<add key=”LogLevel” value=”3” />...

...

</appSettings>

Valid values are 1, 2, 3 and 4. If not set, the log level is set to 3.

6.3 Microsoft ODBC Drivers

For problems connecting a database through ODBC drivers, verify the connection
parameters using MS Query (MSQRY32.EXE) from MS Office.

MS Query makes it possible to access the database through ODBC and see the
structure of tables, available views and field names. For advanced troubleshooting,
tracing can be activated within Windows ODBC configuration.

Default update intervals:

• Server - The Server checks for updates in the update folder at startup and every 60
minutes thereafter.

• Client - The client checks for updates at startup and every 15 hours thereafter.

Please refer to the Microsoft documentation for details.

6.4 Microsoft Windows Server OS

There is no particular method for tracing the communication between Mitel products and
the Windows Server operating system (OS) using only one specific trace tool. However, it
is possible to activate product specific tracing, as described in this document.



Appendix I – Changing to Domain
Account 7

This appendix describes how to change from the local nice account to a domain account.

It is now possible to install CMG with both a local account and a domain account.

Important! Future updates of CMG will fetch the account and the encrypted password from
the registry. If you plan to use a domain account, be sure to create the domain account with
the exact same password as the local nice account, or install nice with the password that the
existing domain account already has.

To change CMG to run on a domain account after the installation, do the following:

1. Start Windows Services.
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2. Double-click on the Nice Server (01) service and change to the domain account. See the
following example:

3. If there is a need to run SQL Server on the same account, double-click on the SQL Server
(MSSQLSERVER) service and change to the domain account. See the following example:

4. If there is a need to run SQL Server Agent on the same account (not valid for SQL Server
Express), double-click on the SQL Server Agent (MSSQLSERVER) service and change to
the domain account. See the following example:
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5. Run \NiceSrv\web\MTSCMGComSetup.exe to change identity for the CMG Components:

6. Remove the local Windows account nice from SQL logins and add ‘DOMAIN\Account’. See
the following example:

Add sysadmin as Server Role for ‘ DOMAIN\Account’.
7. Remove the local Windows account Nice if there is a need for it. See the following

example:
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8. Change the registry parameter ‘Username’:

a. On a 32-bit Windows, change the value of registry parameter HKEY_LOCAL_MACHINE
\SOFTWARE\Netwise\Username to ‘DOMAIN\Account’. See the following example:

b. On a 64-bit Windows, Change the value of registry parameter HKEY_LOCAL_MACHINE
\SOFTWARE\Wow6432Node\Netwise\Username to ‘DOMAIN\Account’. See the
following example:

Note:

The screenshots in this appendix are from a CMG installation on Windows 2008 with SQL
2008. If CMG is installed on Windows 2012/R2 with SQL 2012, the examples would look a
bit different, but the procedure would be the same.



Appendix II – Configuring Single Sign-
On 8
This chapter contains the following sections:

• Single Sign-On for CMG Web

This appendix describes how to configure Single Sign-On on a Windows Server.

For Single Sign-On (SSO) to work, both the CMG Server and the CMG users have to belong
to the same domain.

Note:

The screenshot examples below are from Windows Server 2008 (32-bit).

8.1 Single Sign-On for CMG Web

To configure Single Sign-On for CMG Web, do the following:
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1. Open CMG Configuration Manager.

Base path is: CMG Web => Parameters => Windows Authentication

a. Give the IP or hostname of the AD server to be used for signing on user when
windows authentication is needed:

=> Active Directory Server
b. The LDAP path indicating the part of AD to be used for authentication:

=> Active Directory Path
c. Username and password for connecting to AD server:

=> Active Directory Username

=> Active Directory Password
d. Pick a miscfield in the database to hold the login information:

=> Active Directory User Identifier Field
e. Pick a field in CMG that is unique for a user that is used to match an AD user with a

CMG user:

=> CMG User Identifier Field
f. User authentication type can either be set to CMG or Windows.

Used when forms authentication is configured in IIS Manager:

=> User Authentication Type
2. Open CMG Directory Manager.

a. Enter information in CMG DM for all users in the newly renamed miscfield, in the
format DOMAIN\USERNAME.

3. Open IIS Manager and set Anonymous Authentication to “Disabled” and Windows
Authentication to “Enabled” for CMGWeb:
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USING SAML 9
This chapter contains the following sections:

• TO CONFIGURE SINGLE SIGN-ON FOR SAML
• METADATA FILE FORMAT:
• SAML REQUEST AND RESPONSE EXPECTATIONS

Before configuring Single Sign On for SAML, ensure that the IDP has the following setup:

• The default value of Entity ID for CMG Web is set to MitelBluStarWeb.
• All the users must have a valid email address in CMG Web which are linked to the user

records.
• If the client configuration has multiple CMG Web URLs configured for a single instance,

then all the URLs must be configured on the client’s IDP.
• The SAML response from client IDP must have a valid Signature. For more details on the

format for a valid signature, see the section SAML AUTHENTICATION RESPONSE FROM
IDP TO CMG: on page 93.

• CMG Web will be using the POST URL from metadata file to send SAML request.
• The metadata’s Name ID format must be –

urn:oasis:names:tc:SAML:1.1:nameid-format:emailAddress

9.1 TO CONFIGURE SINGLE SIGN-ON FOR SAML

1. Open the Install directory of CMG Web, default path is: C:\inetpub\wwwroot
\CMGWeb

2. Add the following metadata file configuration:

a. Create a new folder App_Data in the below path:

C:\inetpub\wwwroot\CMGWeb\

b. Copy the IDP metadata file in the App_Data folder, and rename the file as
metadata.xml.
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Note:

You can get the metadata file from the client. For more details on Metadata file
format, see the section Metadata File Format.

3. To configure the SAML CMGWeb.configuration file:

a. Enter the following key details under the <appsettings> tag:

i. <add key="MetadataLocation" value="{Path_Of_Metadata_File}"/>

Enter the path value of the meta data file. The path value is set to value="~/
App_Data/metadata.xml”

ii. <add key="ServiceProviderUrl" value="{CMGWeb_Sign_Page_Url}"/>

Enter the complete CMGWeb Sign In URL. For example:

http://localhost/CMGWeb/SignIn

The domain of the URL specified should be a localhost.
iii. <add key="STSName" value="{Name_of_The_Provider}" />

Enter the STS name, that is, the Name of the Provider. By default, the value is
External Sign In and the client can change this value.

Figure 1: SSO-Login at Identity Provider (IDP)
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9.2 METADATA FILE FORMAT:

The metadata file has attributes value in place of “{}” and requires tags such as
X509Certificate, SingleLogoutService, NameIDFormat and SingleSignOnService. The
metadata file format is as follows:

<?xml version="1.0"?>

<EntityDescriptor 

xmlns="urn:oasis:names:tc:SAML:2.0:metadata" entityID="{}">

<IDPSSODescriptor 

xmlns:ds="http://www.w3.org/2000/09/xmldsig#"

protocolSupportEnumeration="urn:oasis:names:tc:SAML:2.0:protocol">

 <KeyDescriptor use="signing">

<ds:KeyInfoxmlns:ds="http://www.w3.org/2000/09/xmldsig#">

 <ds:X509Data>

<ds:X509Certificate>{}</ds:X509Certificate>

</ds:X509Data>

</ds:KeyInfo>

</KeyDescriptor>

<SingleLogoutService
 Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-Redirect"
 Location="{}"/>

<NameIDFormat>urn:oasis:names:tc:SAML:1.1:nameid-
format:emailAddress</NameIDFormat>

<SingleSignOnService
 Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-POST"
 Location="{}"/>

</EntityDescriptor>
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9.3 SAML REQUEST AND RESPONSE EXPECTATIONS

Ensure that the IDP is compatible with CMG Web’s request and response syntax,
because CMGWeb reads SAML token only in the formats given in the following sections:

• SAML AUTHENTICATION REQUEST FROM CMG WEB TO IDP: on page 92
• SAML AUTHENTICATION RESPONSE FROM IDP TO CMG: on page 93
• SAMPLE METADATA, REQUEST AND RESPONSE on page 96

9.3.1 SAML AUTHENTICATION REQUEST FROM CMG WEB
TO IDP:

1. The SAML authentication request sent to IDP will be in the following format:
2. Here only the AssertionConsumerServiceURL and ID attribute values would be set

when sending a request to IDP.
3. ID – This is the Unique Id generated for each request.
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4. AssertionConsumerServiceURL - This URL is taken from the ServiceProviderUrl
parameter.

<samlp:AuthnRequest ID="{}" Version="2.0"
 IssueInstant="2017-06-08T10:51:27Z"

ProtocolBinding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-POST"
 AssertionConsumerServiceURL="="{}"

xmlns:samlp="urn:oasis:names:tc:SAML:2.0:protocol">

<saml:Issuer
 xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion">MitelBluStarWeb</
saml:Issuer>

<samlp:NameIDPolicy Format="urn:oasis:names:tc:SAML:2.0:nameid-
format:unspecified" AllowCreate="true" />

<samlp:RequestedAuthnContext Comparison="exact">

<saml:AuthnContextClassRef
 xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion">urn:oasis:names:tc:SAML:2.0:ac:classes:PasswordProtectedTransport</
saml:AuthnContextClassRef>

</samlp:RequestedAuthnContext></samlp:AuthnRequest>

9.3.2 SAML AUTHENTICATION RESPONSE FROM IDP TO
CMG:

1. The SAML response that CMGWeb receives from IDP must be in the following format.
2. The {} curly braces enclose the actual values.

<samlp:Response
 xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion"
 xmlns:samlp="urn:oasis:names:tc:SAML:2.0:protocol"
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 ID="{}" Version="2.0" IssueInstant="2017-06-08T10:30:44Z"
 Destination="{recipient}" InResponseTo="{}">

<saml:Issuer>{}</saml:Issuer>

<samlp:Status>

<samlp:StatusCode

Value="urn:oasis:names:tc:SAML:2.0:status:{}"/>

</samlp:Status>

<saml:Assertion
 xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion"
 xmlns:xs="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://
www.w3.org/2001/XMLSchema-instance" Version="2.0"
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 ID="pfx1abc4703-b737-cbc2-bdd5-d35d07edbec6"
 IssueInstant="2017-06-08T10:30:44Z">

<saml:Issuer>{}</saml:Issuer>

<ds:Signature xmlns:ds="http://www.w3.org/2000/09/xmldsig#">

<ds:SignedInfo>

<ds:CanonicalizationMethod Algorithm="http://www.w3.org/2001/10/
xml-exc-c14n#"/>

<ds:SignatureMethod Algorithm="http://www.w3.org/2000/09/
xmldsig#rsa-sha1"/>

<ds:Reference URI="#pfx1abc4703-b737-cbc2-bdd5-d35d07edbec6">

<ds:Transforms>

<ds:Transform Algorithm="http://www.w3.org/2000/09/
xmldsig#enveloped-signature"/>

<ds:Transform Algorithm="http://www.w3.org/2001/10/xml-exc-
c14n#"/>

</ds:Transforms><ds:DigestMethod Algorithm="http://
www.w3.org/2000/09/xmldsig#sha1"/>

<ds:DigestValue>{}</ds:DigestValue>

</ds:Reference>

</ds:SignedInfo>

<ds:SignatureValue>{}</ds:SignatureValue>

<ds:KeyInfo>

<ds:X509Data>

<ds:X509Certificate>{}</ds:X509Certificate>

</ds:X509Data>

</ds:KeyInfo>

</ds:Signature>

<saml:Subject>

<saml:NameID Format="urn:oasis:names:tc:SAML:1.1:nameid-
format:emailAddress">{}</saml:NameID>

<saml:SubjectConfirmation
 Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">

<saml:SubjectConfirmationData
 NotOnOrAfter="2017-06-08T10:33:44Z" Recipient="{recipient}"
 InResponseTo="_01c34e63-e72d-4b5c-b4c7-575b08a08ada"/>

</saml:SubjectConfirmation>

</saml:Subject>

<saml:Conditions NotBefore="2017-06-08T10:27:44Z"
 NotOnOrAfter="2017-06-08T10:33:44Z">

<saml:AudienceRestriction>

<saml:Audience>{audience}</saml:Audience>

</saml:AudienceRestriction>

</saml:Conditions>

<saml:AuthnStatement AuthnInstant="2017-06-08T10:30:43Z"
 SessionNotOnOrAfter="2017-06-09T10:30:44Z"
 SessionIndex="_731e7bc0-2e63-0135-39a2-02af1cf39a00">

<saml:AuthnContext>

<saml:AuthnContextClassRef>urn:oasis:names:tc:SAML:2.0:ac:classes:PasswordProtectedTransport</
saml:AuthnContextClassRef>

</saml:AuthnContext>

</saml:AuthnStatement>

<saml:AttributeStatement>

<saml:Attribute Name="last name"
 NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic">

<saml:AttributeValue xmlns:xsi="http://www.w3.org/2001/
XMLSchema-instance" xsi:type="xs:string">{}</
saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="company"
 NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic">

<saml:AttributeValue xmlns:xsi="http://www.w3.org/2001/
XMLSchema-instance" xsi:type="xs:string">{}</
saml:AttributeValue>

</saml:Attribute>

</saml:AttributeStatement>

</saml:Assertion>

</samlp:Response>
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9.3.3 SAMPLE METADATA, REQUEST AND RESPONSE

Metadata File Sample:

<?xml version="1.0"?>

<EntityDescriptor xmlns="urn:oasis:names:tc:SAML:2.0:metadata"
 entityID="https://app.onelogin.com/saml/metadata/644310">

<IDPSSODescriptor xmlns:ds="http://www.w3.org/2000/09/xmldsig#"
 protocolSupportEnumeration="urn:oasis:names:tc:SAML:2.0:protocol">

<KeyDescriptor use="signing">

<ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#">

<ds:X509Data</ds:X509Data></ds:KeyInfo></KeyDescriptor>

<SingleLogoutService
 Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-Redirect"
 Location="https://qwert-dev.onelogin.com/trust/saml2/http-
redirect/slo/644310"/>

<NameIDFormat>urn:oasis:names:tc:SAML:1.1:nameid-
format:emailAddress</NameIDFormat>

<SingleSignOnService
 Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-Redirect"
 Location="https://qwert-dev.onelogin.com/trust/saml2/http-
redirect/sso/644310"/>

<SingleSignOnService
 Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-POST"
 Location="https://qwert-dev.onelogin.com/trust/saml2/http-post/
sso/644310"/>

<SingleSignOnService
 Binding="urn:oasis:names:tc:SAML:2.0:bindings:SOAP"
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 Location="https://qwert-dev.onelogin.com/trust/saml2/soap/
sso/644310"/>

</IDPSSODescriptor>

</EntityDescriptor>

Authentication Request Sample:

<samlp:AuthnRequest ID="_4fd95a67-8e72-4054-91d5-c7fb3d0c8b9a"
 Version="2.0" IssueInstant="2017-06-08T10:51:27Z"
 ProtocolBinding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-
POST" AssertionConsumerServiceURL="http://localhost:58267/
SignIn" xmlns:samlp="urn:oasis:names:tc:SAML:2.0:protocol">

<saml:Issuer
 xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion">MitelBluStarWeb</
saml:Issuer>

<samlp:NameIDPolicy Format="urn:oasis:names:tc:SAML:2.0:nameid-
format:unspecified" AllowCreate="true" />

<samlp:RequestedAuthnContext Comparison="exact">

<saml:AuthnContextClassRef
 xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion">urn:oasis:names:tc:SAML:2.0:ac:classes:PasswordProtectedTransport</
saml:AuthnContextClassRef>

</samlp:RequestedAuthnContext>

</samlp:AuthnRequest>

SAML Response sample:

<samlp:Response
 xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion"
 xmlns:samlp="urn:oasis:names:tc:SAML:2.0:protocol"
 ID="R0141a8dfa0ed8f47d0d7034f6e55dde257620ad3" Version="2.0"
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 IssueInstant="2017-06-08T10:30:44Z" Destination="{recipient}"
 InResponseTo="_01c34e63-e72d-4b5c-b4c7-575b08a08ada">

<saml:Issuer>https://app.onelogin.com/saml/metadata/644310</
saml:Issuer>

<samlp:Status>

<samlp:StatusCode
 Value="urn:oasis:names:tc:SAML:2.0:status:Success"/>

</samlp:Status>

<saml:Assertion
 xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion"
 xmlns:xs="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://
www.w3.org/2001/XMLSchema-instance" Version="2.0"
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 ID="pfx1abc4703-b737-cbc2-bdd5-d35d07edbec6"
 IssueInstant="2017-06-08T10:30:44Z">

<saml:Issuer>https://app.onelogin.com/saml/metadata/644310</
saml:Issuer>

<ds:Signature xmlns:ds="http://www.w3.org/2000/09/xmldsig#">

<ds:SignedInfo>

<ds:CanonicalizationMethod Algorithm="http://www.w3.org/2001/10/
xml-exc-c14n#"/>

<ds:SignatureMethod Algorithm="http://www.w3.org/2000/09/
xmldsig#rsa-sha1"/>

<ds:Reference URI="#pfx1abc4703-b737-cbc2-bdd5-
d35d07edbec6"><ds:Transforms>

<ds:Transform Algorithm="http://www.w3.org/2000/09/
xmldsig#enveloped-signature"/>

<ds:Transform Algorithm="http://www.w3.org/2001/10/xml-exc-
c14n#"/>

</ds:Transforms>

<ds:DigestMethod Algorithm="http://www.w3.org/2000/09/
xmldsig#sha1"/>

<ds:DigestValue>WqKsIdUb9/p41184UaTxsB2jS+I=</ds:DigestValue>

</ds:Reference>

</ds:SignedInfo>

<ds:SignatureValue> ==</ds:SignatureValue>

<ds:KeyInfo>

<ds:X509Data>

<ds: >

</ds:X509Data>

</ds:KeyInfo>

</ds:Signature>

<saml:Subject>

<saml:NameID Format="urn:oasis:names:tc:SAML:1.1:nameid-
format:emailAddress">qwert@test.com</saml:NameID>

<saml:SubjectConfirmation
 Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">

<saml:SubjectConfirmationData
 NotOnOrAfter="2017-06-08T10:33:44Z" Recipient="{recipient}"
 InResponseTo="_01c34e63-e72d-4b5c-b4c7-575b08a08ada"/>

</saml:SubjectConfirmation>

</saml:Subject>

<saml:Conditions NotBefore="2017-06-08T10:27:44Z"
 NotOnOrAfter="2017-06-08T10:33:44Z">

<saml:AudienceRestriction>

<saml:Audience>{audience}</saml:Audience>

</saml:AudienceRestriction>

</saml:Conditions>

<saml:AuthnStatement AuthnInstant="2017-06-08T10:30:43Z"
 SessionNotOnOrAfter="2017-06-09T10:30:44Z"
 SessionIndex="_731e7bc0-2e63-0135-39a2-02af1cf39a00">

<saml:AuthnContext>

<saml:AuthnContextClassRef>urn:oasis:names:tc:SAML:2.0:ac:classes:PasswordProtectedTransport</
saml:AuthnContextClassRef>

</saml:AuthnContext>

</saml:AuthnStatement>

<saml:AttributeStatement>

<saml:Attribute Name="last name"
 NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic">

<saml:AttributeValue xmlns:xsi="http://www.w3.org/2001/
XMLSchema-instance" xsi:type="xs:string">Qwert</
saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="email"
 NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic">

<saml:AttributeValue xmlns:xsi="http://www.w3.org/2001/
XMLSchema-instance" xsi:type="xs:string">qwert@test.com</
saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="first name"
 NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic">

<saml:AttributeValue xmlns:xsi="http://www.w3.org/2001/
XMLSchema-instance" xsi:type="xs:string">Qwert</
saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="phone"
 NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic">

<saml:AttributeValue xmlns:xsi="http://www.w3.org/2001/
XMLSchema-instance" xsi:type="xs:string">1000</
saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="company"
 NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:basic">

<saml:AttributeValue xmlns:xsi="http://www.w3.org/2001/
XMLSchema-instance" xsi:type="xs:string">wipro</
saml:AttributeValue>

</saml:Attribute>

</saml:AttributeStatement>

</saml:Assertion>

</samlp:Response>
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Appendix III – Using Import Export
Configuration Tool 10
This chapter contains the following sections:

• Export Configuration
• Import Configuration
• Event Viewer
• Printing Import/Export Configuration
• Settings
• Additional Information
• Queries
• Support

This appendix describes how to use the Import Export Configuration tool, which is used to
configure the Import and Export jobs in CMG.

The Import Export Configuration tool is located in the <drive:>\NiceSrv\pgm directory
and is called ImpExpCfg.

10.1 Export Configuration

This section describes how to do an export configuration.

Do the following:

1. Open the Import/Export Configuration Tool.
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2. On the start screen, click File and then select New (or Open or Delete) to display the
New job dialog:

The title bar shows the kind of operation being performed (in this case New job).
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3. Select the Database, the Type of job and the Name in Spman, then click
Parameters.

A new section (Parameters) appears in the dialog.
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4. Type when and how often the job should run, then click Layout & Fields.

The following dialog is displayed:

The title bar shows the name of the job being edited.
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5. Define the Export text file (see example in the previous dialog) and click on the Export
Fields tab. The following dialog is displayed:
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6. Select the fields to be exported from Available fields, and then click Save.

The following dialog is displayed:

From this dialog, the job can be tested and the exported text file can be viewed.

10.2 Import Configuration

This section describes how to import a configuration. The Import configuration process is
similar to Export configuration, except that there are three tabs to configure.

• Layout Tab on page 106
• Default Values Tab on page 108
• Import Fields Tab on page 108
• Importing the Text File on page 109

10.2.1 Layout Tab

The Import text file is specified on the Layout tab.
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Ensure the imported data field values do not include any of the following permanently
restricted characters.

< | ; “ &#

Note:

“&#” as a combination is not allowed. “&”and “#” as single characters are still allowed.

There are some other special characters that are not allowed in DM 8.5 version
by default. But, you can choose to allow these characters or restrict it in CMG CM
application.

To configure the list of allowed and restricted characters, go to CMG Directory Manager
> Parameters > ExceptionCharactersList.
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Note:

If these restricted characters are included in any of the imported data fields, then the
import will fail to CMG and this will be logged in the import log file.

10.2.2 Default Values Tab

The default values for fields that are not imported are configured on the Default Values
tab.

10.2.3 Import Fields Tab

The fields into which data has to be imported are selected on the Import Fields tab.
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10.2.4 Importing the Text File

When all values have been specified and saved, the following dialog is displayed:
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From this dialog, the job can be tested and the import text file can be viewed.

If anything goes wrong, use the Windows Event Viewer to check for errors. In this case,
the job has to be restarted from Spman tool.

10.3 Event Viewer

Event Viewer is launched from the menu Programs > Event Viewer.
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Sometimes, Nice Service stops after an Export or Import. If this happens, start it again
from Windows Services. Services can be started from the menu Programs > Services.
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10.4 Printing Import/Export Configuration

If Import/Export is successful and you want to implement it somewhere else, the
configuration can be printed out from the menu File > Print Import/Export Conf.

If Import/Export is not successful, you can save it as a text file and send to Mitel Support
for investigation.

10.5 Settings

If supporting a CMG System in another language, fields that can be re-named can also
be displayed in any supported language. Choose menu Settings > Language
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To be able to display the re-named fields in the selected language, the correct version
of SQL has to be specified. Click Settings, select SQL Version, and type the number
corresponding to the SQL version.

10.6 Additional Information

The Help menu contains other options, as shown in the following figure:
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Programs can be started from the menu Programs as shown in the following figure:

Note:

Spman tool will get a new branch in the registry where statistics are located.Do not
edit this branch.

Document Version 1.0

CMG Configuration Guide 114



Appendix III – Using Import Export Configuration Tool

10.7 Queries

You can use the configuration tool to get answers about records in the database.

You can use the configuration tool to determine what alternatives you can enter in
the fields. Check the import text file for errors. Match fields from a post towards the
configuration to see where the data will go.

You can use the configuration tool to find out what you can expect from an export of data.

You can use the configuration tool to get help when filtering records for an export.
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10.8 Support

If you encounter any trouble regarding the configuration tool, do the following:

1. Go to Help > Support and click Copy to clipboard.
2. Attach the info from the clipboard to the error report.
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Appendix IV - Setting up User
Authentication 11
This chapter contains the following sections:

• CMG Forms Authentication
• Windows Forms Authentication
• Windows Authentication in IIS
• Automatic Windows Forms Authentication
• Active Directory Federation Services (ADFS) Authentication

There are multiple ways of authenticating users in CMG Web:

• CMG user authentication using Forms Authentication with Extension and password, the
same as in Office Web. This is the default authentication setting after installation.

• Windows authentication using Forms Authentication with Windows user and password.
LDAP is used to fetch a user unique field to match to a CMG user.

• IIS Windows authentication with automatic logon, Windows authentication performed in IIS.
If the Windows account information is not provided by the browser, the user is prompted for
credentials in a separate dialog.

• Automatic Windows authentication with Forms Authentication if Windows authentication
fails. If the browser does not provide the correct Windows user credentials, the Forms
Authentication is offered to the user. The Forms Authentication can be either CMG user
authentication or Windows authentication based on the configuration.

• ADFS authentication

11.1 CMG Forms Authentication

In IIS Manager, change Authentication - Forms Authentication to Enabled and leave
the Anonymous Authentication set to Enabled for the CMG Web Website.
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If no authentication is required in order to perform a search in the CMG Web GUI, then
you can set the parameter “DirectoryPageRequireAuthentication” to “false” in Application
Settings Application Settings for the CMG Web in IIS Manager.

11.2 Windows Forms Authentication

1. Add the server running the CMG Server to the Windows domain.
2. In IIS Manager, change Authentication - Forms Authentication to Enabled for the

CMG Web Website.
3. Set up the parameters for Windows Authentication in CMG Configuration Manager.

Do the following:

a. Open CMG Configuration Manager and expand CMG Web in the sidebar. Select
Parameters and navigate to Windows Authentication.

b. Set up the Active Directory access parameters to access AD through LDAP.
c. Set User Authentication Type to Windows.
d. Enter the correct values in the fields Active Directory User Identifier Field and

CMG User Identifier Field. These fields are used to match the Windows user to a
CMG user and the values have to be user unique and matched. The e-mail address
is used default to match the user.

11.3 Windows Authentication in IIS

1. Add the server running the CMG Server to the Windows domain.
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2. In IIS Manager, change Authentication - Windows Authentication to Enabled and
all the other authentication options set to Disabled for the CMG Web Website.

3. In IIS Manager check Providers for Windows Authentication so that NTLM is the
enabled provider.

4. Set up the parameters for Windows Authentication in CMG Configuration Manager.
Do the following:

a. Open CMG Configuration Manager and expand CMG Web in the sidebar. Select
Parameters and navigate to Windows Authentication.

b. Set up the Active Directory access parameters to access AD through LDAP.
c. Enter the correct values in the fields Active Directory User Identifier Field and

CMG User Identifier Field. These fields are used to match the Windows user to a
CMG user and the values have to be user unique and matched. The email address
is used by default to match the user.

11.4 Automatic Windows Forms Authentication

1. Add the server running the CMG Server to the Windows domain.
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2. In IIS Manager, change Authentication - Anonymous Authentication and Windows
Authentication to Enabled to for the CMG Web Website.

3. In IIS Manager check Providers for Windows Authentication so that NTLM is the
enabled provider.

4. Set up the parameters for Windows Authentication in CMG Configuration Manager.
Do the following:

a. Open CMG Configuration Manager and expand CMG Web in the sidebar. Select
Parameters and navigate to Windows Authentication.

b. Set up the AD access parameters to access AD through LDAP.
c. Set User Authentication Type to CMG or Windows, depending on what type of

authentication is to be offered in the Forms Authentication.
d. Enter the correct values in the fields Active Directory User Identifier Field and

CMG User Identifier Field. These fields are used to match the Windows user to a
CMG user and the values have to be user unique and matched. The e-mail address
is used default to match the user.

11.5 Active Directory Federation Services (ADFS)
Authentication

Active Directory Federation Services (ADFS) simplifies access to systems and
applications using a claims-based access (CBA) authorization mechanism to maintain
application security. For more information, please refer to: http://technet.microsoft.com/
en-us/windowsserver/dd448613.aspx

1. In the C:\inetpub\wwwroot\CMGWeb directory:

a. Delete the existing web.config file.
b. Rename the web.adfs.config file to web.config.
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2. In the new web.config file, configure <appSettings>:

a. Set the value of UserClaimType to an ADFS claim type, which contains the
information to match with a CMG field (typically a claim type that contains the e-mail
address of the users), see step 6.

b. Set a value of Claim<x> to filter on, for example, a group or a company.
3. Make sure that your ASP.NET application’s URL and port number match the values in

the audienceUris entry, for example,

<audienceUris>

<add value="http://localhost/CMGWeb" />

</audienceUris>

4. Set a trusted issuer, for example:

<trustedIssuers>

<add thumbprint=" 1234567890ABCDEFGHIJKLMNOPQRSTUVWXYZ1234"
 name="YourSTSName" />

</trustedIssuers>

It is possible to have several <trustedIssuers> elements.
5. Make sure that the issuer value fits your Security Token Service (STS) URL and

that your ASP.NET application’s URL and port number match the values in the realm
attribute of the <wsFederation> element:

<wsFederation passiveRedirectEnabled="true"

issuer="http://localhost:13922/wsFederationSTS/Issue/"

 realm="http://localhost/CMGWeb" requireHttps="true" />

6. Open CMG Configuration Manager and expand CMG Web in the sidebar. Select
Parameters and navigate to Windows Authentication.

a. Enter the correct values in the field CMG User Identifier Field. This field is used
to match the domain user to a CMG user, and should indicate which CMG field that
contains the information to match with the content of the claim type specified in step
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2The setting should typically be set to MSGID to indicate that the e-mail address of
the user in CMG should match the content of the claim type from ADFS.

Note:

When setting up ADFS and IIS you need to configure the IIS site (BSW) application
pool to set the Process model -> load user profile to ‘true’.



Appendix V - CMG Web Multi-Server
Deployment 12
This chapter contains the following sections:

• Configure Server Address for CMG Web Service
• Configure CMG Web Service

Multiple CMG Web sites can be deployed using the same CMG Web Service. The CMG Web
sites can use different authentication methods and the application settings can be configured
individually for each site.

12.1 Configure Server Address for CMG Web Service

To connect CMG Web to CMG Web Service on another server, the following
configuration has to be done in IIS:

1. Open IIS Manager, then select Application Settings.
2. In the Application Settings window, update the CMGWebServiceBaseUrl setting

with the address of the other server.

12.2 Configure CMG Web Service

If CMG Web Service is deployed on another server than the CMG Server, the
configuration file CMGWebServiceConfig.xml, located in the folder of CMG Web
Service, has to be modified.
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Set the following parameters, where the CMG Server, AnA and CWI web services are
assumed to be installed on a server named cmgsrv:

<CmgDatabaseConnectionString>

server=cmgsrv;database=nice;User ID=nice;Password=thepassword

</CmgDatabaseConnectionString>

<CmgUserInformationServiceUrl>

http://cmgsrv/CMGUserInformationService/CMGUserService.asmx

</CmgUserInformationServiceUrl>

<CmgActivityServiceUrl>

http://cmgsrv/CMGActivityService/CMGActivityService.asmx

</CmgActivityServiceUrl>

<AnAServiceUrl>

 http://cmgsrv/nwAna/AnAService.asmx

</AnAServiceUrl>



Appendix VI - Connecting to the PBX 13
This chapter contains the following sections:

• Connecting to Mitel TSW (serial)
• Connecting to Mitel TSW (with NIU2 board)
• Connecting to MiVoice MX-ONE
• Connecting to BusinessPhone

13.1 Connecting to Mitel TSW (serial)

This appendix describes the common installation and configuration procedure for the
communication between a CMG Server and one Mitel TSW with serial interface.

This description has to be used only when the serial interface from the PBX is connected
directly to the COM port of the CMG Server.

• Before the Installation on page 126
• Installation Steps on page 127
• Verify Call Forwarding on New Activity on page 127

13.1.1 Before the Installation

Before starting the configuration, note the following considerations:

• Available com port(s) at the CMG Server
• Speed and parity of the serial device/interface from the PBX. For example:

• Speed = 2400
• Parity = 8
• Bits = 1
• StopBits = None

• ExtLth of the PBX. If the internal phone numbers are within the interval 1000 – 9999
then, normally the ExtLth = 4, 10 000 – 99 999 then the ExtLth = 5, and so on.

• What to name the PBX in the CMG system.

The serial communication between the CMG Server and Mitel TSW requires one com
port. The interface communicates to the IDP-unit in the Mitel TSW through the NIU2
board.
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13.1.2 Installation Steps

1. Connect the cable from the PBX to a COM port in the CMG Server.
2. Open CMG Configuration Manager.
3. Choose PBX’s/Flash Clients in the left frame.
4. As you will see, PBX number 1 is already installed by default with ExtLth=4.

Change the type and values to fit your system and save.
5. Highlight the PBX. Extensions 1000-9999 are added as default.

Change the values to fit your system and save.
6. Start Spman tool.
7. Highlight the pre-configured PBXSTD001 process and control the settings.
8. The picture below describes the relationship between the key processes. Control and

– if necessary – modify the settings for the PBXSTD001 and PBXGWHVD01 process.
These processes are pre-configured in Spman tool.

9. If you have edited the processes, highlight PBXSTD001 and PBXGWHVD01 and
choose Stop, then Start and then Refresh.

10. If the processes started without any errors, it is recommended that you also refresh
the following processes: DBtoPBX, IRTIMER, DELIR, MRTIMER, NICESRV, and the
process for the IVR (if there is one).

13.1.3 Verify Call Forwarding on New Activity

1. Open CMG Directory Manager.
2. Choose New record in the left frame. Add a test individual and type the extension

number to a telephone that is nearby. Be sure to give the record the correct PBX id or
PBX name. Save the record.

3. Start CMG Web or the InAttend client and add a new current activity for your test
individual.
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4. Check the telephone whose extension you used for the test record. Verify that
forwarding is enabled on the phone, for example to the operator or the IVR system.

5. Delete the activity.
6. Add a new activity using the telephone (*23*…).
7. Check on the telephone that it is forwarded.
8. Check in CMG Web or the InAttend client that the activity has been entered.

13.2 Connecting to Mitel TSW (with NIU2 board)

This is a description of the common way to install and configure the communication
between a CMG Server and Mitel TSW with NIU2 (Network interface unit) board.

• Before the Installation on page 128
• Installation Steps on page 128
• Verify Call Forwarding on New Activity on page 129

13.2.1 Before the Installation

Before starting the configuration, note the following considerations:

• Available IP-ports at the CMG Server.
• IP address for the CMG Server.
• IP port of the PBX.
• ExtLth of the PBX. If the extension numbers are within the interval 1000 – 9999 then,

normally the ExtLth = 4, 10 000 – 99 999 then the ExtLth = 5, and so on.
• What to name the PBX in the CMG system

The interface from the PBX to the CMG Server requires that the correct IP no for the
CMG Server is properly set in the PBX. At the CMG Server you only need to set the right
IP port number to/from the PBX.

13.2.2 Installation Steps

1. Open CMG Configuration Manager.
2. Choose PBX’s/Flash Clients in the left frame.
3. PBX number 1 is already installed by default with ExtLth=4. Change the type and

values to fit your system and save.
4. Highlight the PBX. Extensions 1000-9999 are added as default. Change the values to

fit your system and save.
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5. Start Spman tool.
6. The picture below shows the relationship between the key processes. Control and –

if necessary – modify the settings for the PBXSTD001 process. This process is pre-
configured in Spman.

7. If you have edited the process, highlight PBXSTD001 and choose Stop, then Start and
then Refresh.

8. If the process started without any errors, it is recommended to also refresh the
following processes: DbToPBX, IRTIMER, DELIR, MRTIMER, NICESRV, and the
process for the IVR (if there is one).

13.2.3 Verify Call Forwarding on New Activity

1. Open CMG Directory Manager.
2. Choose New record in the left frame. Add a test individual and type the extension

number to a telephone that is nearby. Make sure you give the record the correct PBX
id or PBX name. Save the new record.

3. Start CMG Web or the InAttend client and add a new current activity for your test
individual.

4. Check the telephone whose extension you used for the test record. Verify that
forwarding is enabled on the phone, for example to the operator or the IVR system.

5. Delete the activity.
6. Add a new activity using the telephone (*23*…).
7. Check on the telephone that it is forwarded.
8. Check in CMG Web or the InAttend client that the activity has been entered.

13.3 Connecting to MiVoice MX-ONE

This section describes the common way to install and configure the communication
between a CMG Server and MiVoice MX-ONE.

Document Version 1.0

129 CMG Configuration Guide



Appendix VI - Connecting to the PBX

• Before the Installation on page 130
• Installation Steps on page 130
• Verify Call Forwarding on New Activity on page 133

13.3.1 Before the Installation

Before starting the configuration, note the following considerations:

• Available IP ports at the CMG Server.
• IP address for the CMG Server.
• IP port of the PBX.
• ExtLth of the PBX. If the extension numbers are within the interval 1000 – 9999 then,

normally the ExtLth = 4, 10 000 – 99 999 then the ExtLth = 5, and so on.
• What to name the PBX in the CMG system.

The interface from the PBX to the CMG Server requires that the correct IP address for
the CMG Server is properly set in the PBX. At the CMG Server you only need to set the
right IP port number to/from the PBX.

13.3.2 Installation Steps

1. Open CMG Configuration Manager.
2. Choose PBX’s/Flash Clients in the left frame.
3. PBX number 1 is already installed by default with ExtLth=4. Change the type and

values to fit your system and save.
4. Highlight the PBX. Extensions 1000-9999 are added as default. Change the values to

fit the system and save.
5. Start Spman tool.
6. The picture below shows the relationship between the key processes. Control and –

if necessary – modify the settings for the PBXSTD001 process. This process is pre-
configured in Spman.

7. If you have edited the process, highlight PBXSTD001 and choose Stop, then Start
and then Refresh.
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8. If the process started without any errors, it is recommended that you also refresh the
following processes: DbToPBX, IRTIMER, DELIR, MRTIMER, NICESRV, and the
process for the IVR (if there is one).

Note:

If adding more PBXs, this is done manually. You need to add a new PBX from
Configuration Guide - CMG.

• How to add PBXSTD for multiple PBXs. on page 131

13.3.2.1 How to add PBXSTD for multiple PBXs.

To add PBXSTD for multiple PBXs, follow the below steps:

1. First, launch the Spman > Click the Edit tab.

2. Select New button.
3. Type the desired Program name (Ex: PBXSTD002).
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4. Enter the Program Path as “pbxstdniu.exe”.
5. Provide the below details for the remaining parameters:

a. Parameters = "I -5"
b. Wait = "0"
c. Max restarts = "3"
d. Start Order = "0"

6. Check the Enabled check box.
7. Click Save to save the changes made.

To start the new PBXSTD program, toggle to Status tab from Spman.

• Select the new program name that was given above.

(in this example, it is PBXSTD002)
• Click the Start button.

The new PBXSTD program is added and started.
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13.3.3 Verify Call Forwarding on New Activity

1. Open CMG Directory Manager.
2. Choose New record in the left frame. Add a test individual and type the extension

number to a telephone that is nearby. Ensure that you give the record the correct PBX
id or PBX name. Save the new record.

3. Start CMG Web or the InAttend client and add a new current activity for your test
individual.

4. Check the telephone whose extension you used for the test record. Verify that
forwarding is enabled on the phone, for example to the operator or the IVR system.

5. Delete the activity.
6. Add a new activity via the telephone (*23*…).
7. Check on the telephone that it is forwarded.
8. Check in CMG Web or the InAttend client that the activity has been entered.

13.4 Connecting to BusinessPhone

This section describes the common way to install and configure the communication
between a CMG Server and a BusinessPhone.

• Before the Installation on page 133
• Installation Steps on page 134
• Verify Call Forwarding on New Activity on page 134

13.4.1 Before the Installation

Before starting the configuration, note the following considerations:

• Available IP ports at the CMG Server.
• IP address for the CMG Server.
• IP port on the PBX (default 2555).
• What to name the PBX in the CMG system.

The interface from the PBX to the CMG Server requires that the BusinessLinkClient is
installed on the CMG Server.
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13.4.2 Installation Steps

1. Open CMG Configuration Manager.
2. Choose PBX’s/Flash Clients in the left frame.
3. PBX number 1 is already installed by default with ExtLth=3.

Change the type and values to fit your system and save.
4. Highlight the PBX. Extensions 100−999 are added as default.

Change the values to fit the system and save.
5. Start Spman tool.
6. The picture below shows the relationship between the key processes.

Control and – if necessary – modify the settings for the PBXSTD001 process. This
process is pre-configured in Spman.

7. Start the PBXSTD001 process.

8. If you have edited the process, highlight PBXSTD001 and choose Stop, then Start and
then Refresh.

9. If the process started without any errors, it is recommended that you also refresh the
following processes: DbToPBX, IRTIMER, DELIR, MRTIMER, NICESRV, and the
process for the IVR (if there is one).

13.4.3 Verify Call Forwarding on New Activity

1. Open CMG Directory Manager.
2. Choose New record in the left frame. Add a test individual and type the extension

number to a telephone that is nearby. Ensure you give the record the correct PBX id or
PBX name. Save the new record.

3. Start CMG Web or the InAttend client and add a new current activity for your test
individual.
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4. Take a look at the telephone you chosen. Check if the phone is forwarded, for example
to the operator or the IVR system.

5. Delete the activity.
6. Add a new activity via the telephone (*23*…).
7. Check on the telephone that it is forwarded.
8. Check in CMG Web or the InAttend client that the activity has been entered.



Appendix VII – Connecting to the E-
mail System 14
This chapter contains the following sections:

• Connecting to E-mail System using SMTP

14.1 Connecting to E-mail System using SMTP

Consider the following prerequisites:

• A connection to a customer’s e-mail server using SMTP
• An e-mail account that is allowed to send e-mail

• Installation Steps on page 137
• Configuration of the E-mail Connection in CMG CM on page 138
• Verify the E-mail Function on page 138
• Troubleshooting on page 138
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14.1.1 Installation Steps

1. Configure the e-mail server registry parameters.

Start Spman tooland configure SMTPSRV.

See CMG Server System Process Description [5] for configuration information.

Set the following values:

"MailUserName" = cmg.system@customer.com (Example of mail user name)

"MailUserPwd" = ********* (Password for the above mail user)

"MailHost" = = MailServerAddress (IP address or host name to the receiving email
server)

"MailFrom" = cmg.system@customer.com (normally be equal to the MailUserName
above)

"MailPort" = (Can be empty)

"IsSSLEnabled" = "0" (0 for disabled, 1 for enabled)

“TLSVersion”=(Empty when IsSSLEnabled=0 but 1.0, 1.1 or 1.2 when
IsSSLEnabled=1)
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Note:

Depending on the specific customer environment, a certificate might be needed on
the CMG server.

14.1.2 Configuration of the E-mail Connection in CMG CM

1. Open CMG Configuration Manager.
2. Select Message Systems in the sidebar. Some settings are optional. The default

program name, e-mail, relates to the MAPISRV-process in Spman default.
3. Change program MAPISRV to SMTPSRV.
4. Leave rest of parameters with default values.

14.1.3 Verify the E-mail Function

1. When the parameters and configuration are completed, start Spman tool, and restart
MSGSND and SMTPSRV.

2. Start the InAttend client and pick up your “Test individual”.
3. Choose the right message System.
4. Choose “New Message”.
5. Add a manual timestamp and a relevant text in the body and send it.

Example: “Test nr 1, Time 15:31”
6. Verify that the mail was successfully delivered.

14.1.4 Troubleshooting

1. Start process with log level 6:

Spman – SMTPSRV –parameters -c 1 -n smtpsrv -l 6

2. Make sure that the used IP address or host name is correct.
3. Check that SMTP is enabled on the e-mail server.
4. Check that the CMG Server has user rights to connect on port 25.
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5. Check if there is any software or hardware firewall blocking port 25.
6. Check the Spman parameter mailfrom. This user must have access to send e-mail.



Appendix VIII – Change Nice Password
in SQL Server 15
This chapter contains the following sections:

• ChangeNicePwd.exe Usage

If you want to change the password in SQL for the database user nice or qmuser, use the tool
ChangeNicePwd, which will update registry and necessary tables in SQL, and in the SQL
Server.

15.1 ChangeNicePwd.exe Usage

Start \nicesrv\pgm\ChangeNicePwd.exe and do the following:

1. Select the database user to be changed (nice).
2. Enter the password (the current password for the nice account).
3. Check for access to the registry and to the database.
4. Change in files, registry, and database, and in SQL.
5. Reboot the server if password is changed in SQL.
6. After the steps 1 – 4 are executed, all the servers involved have to be rebooted (CMG/

CMG Speech/CMGSpeech Telephony/BluStar Server).
7. Copy “ChangeNicePwd.exe” to any of the folder among the servers involved

(CMG/CMG Speech/CMGSpeech Telephony/BluStar Server).
8. The file “UMSCoder.exe” also needs to be copied to the same folder as

ChangeNicePwd on the server containing BluStar Server.
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Technical Assistance 16

Mitel provides www.mitel.com as a starting point for technical assistance regarding all
products, including CMG. From here, partners can obtain online documentation, FAQs, latest
software updates and request further technical assistance.
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